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Notices
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Introduction: Target Audience and Products
1. Introduction 

1.1. Target Audience and Products

1.1.1. Target Audience
You are a “printer administrator” with responsibility for configur-
ing and administrating printers and print servers. You may also 
be a “network administrator”, and if not, you will sometimes 
need to talk with one.
The information in this manual does not cover special option 
settings intended for our partners. Please contact our support 
department if you need information about the special “OEM” 
settings. 

1.1.2. Print Servers and Component Codes Covered

K92_1491
Main code level K92_1491 is the last release (from December 
2001) supporting Novell NetWare IPX/SPX-based printing. 
Effective 4 January 2002, the LAN FS3 will not be sold with 
IPX/ SPX-based NetWare print support for Bindery and NDS 
modes. Due to license issues, down-grading an Intermate LAN 
FS3 purchased after 4 January 2002 (K92_2011 and higher) 
will constitute a copyright violation. 
Please note, however, that you can print through the Intermate 
LAN FS3 from a NetWare platform based on pure IP, such as 
that in NetWare 5 (released in 1998).The combination of stan-
dard LPD and SNMP implementations in the print server will 
support the standard NDPS Gateway delivered with NetWare 
5, thus providing a controlled bi-directional print method. Con-
sult your NetWare documentation for help in setting up a 
printer; you will not need any special settings in the Intermate 
LAN FS3.

K92_2011
Main code level K92_2011 is the first release (from January 
2002) supporting IPP.
Intermate LAN FS3  Print Server Administration Manual 12 
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1.2. Types of Documentation 

1.2.1. Manuals and Guides
The set of Manuals and Guide provided on the CD—and 
updated on our web site— includes the Print Server Adminis-
tration Manual (this book) and the Printing Environment 
Guides.

The Print Server Administration Manual tells you how to 
configure server-wide settings (with more information on IP-
configuration than is provided in Getting Started or the Quick 
Guide), and how to configure the basic printing services: Raw 
Socket, LPR, FTP, and IPP. It also describes tools you can use 
for monitoring/managing, troubleshooting and maintenance. 
The Printing Environment Guides give information on print-
ing from different environments.Included in each guide are not 
only the details of special settings on your Intermate LAN FS3, 
but also information on how to configure the platform from 
which printing is to be done. In addition, troubleshooting for 
each particular environment is covered.

• In connection with each guide for IBM environments, 
there is the appropriate information for using the 
applicable Host Print Options (the HPOs), 
encompassing AFP/IPDS, SCS TN3270E, and SCS 
TN5250E). The Printing Environment Guide for IBM 
OS/400 Systems including the IPDS and SCS 
TN5250E HPOs is ready. 

• We expect to have all the Printing Environment Guides 
on our web-site by the end of February, 2002. In the 
mean time, if you use the HPO for SCS TN3270E (IBM 
Mainframe Hosts), please consult the LAN FS3 10/100 
Ethernet User’s Guide (KL-008-2).

Note that all information on license keys, firmware upgrade 
and customer support is collected in the Server Administration 
Guide. 
Please note the following restrictions on the HPOs:
Intermate LAN FS3  Print Server Administration Manual 13 



Introduction: Types of Documentation
•  “IPDS Option”. If you enable and use this option without 
having a license key, each page will be overwritten with 
a “Demo/Test Mode” banner. IPDS printing is only 
available on monochrome printers with at least 12 MB 
RAM.

•  “TN5250E Option”. If you enable this option and use it 
to print SCS jobs or jobs using Host Print Transform 
without having a license key, the last line on each 
printed page will be overwritten with a “demo mode” 
message. 

•  “TN3270E Option”. If you enable this option and use it 
to print SCS jobs without having a license key, the last 
line on each printed page will be overwritten with a 
“demo mode” message.

1.2.2. Other Types of Documentation
There are three types of documentation:

• Product Overview is a sheet included with the 
package. 
It lists what is in the package, including the contents of 
the CD-ROM and information on updates.

• Getting Started is a brochure included with the 
package, covering hardware installation, information 
on getting IP-connected and information on how to start 
printing from a Windows 2000 platform.

• Quick Guide is a mini-manual in text-format which can 
be printed directly from the print server. It is meant 
especially to rescue users who don’t have anything 
else at hand.

All three types are also included on the CD-ROM and available 
on our web-site.
Because the Intermate LAN FS3 integrates so deeply with your 
printer, you should always have access to printer documenta-
tion.
Intermate LAN FS3  Print Server Administration Manual 14 
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1.3. Conventions Used in the Manual and Guides 
The notation used is based on what you see in  the HTTP-
based dialog for management and configuration. 
This dialog has a left menu divided into group, sub-groups and 
items. When we refer to such groups, sub-groups or items, we 
use “double quotes” and connect the levels with a right angled 
bracket >. 
“Configuration > Input Control > LPR” is an example of “Group 
> Sub-Group > Item”.
Many of the items open a configuration page. In descriptions of 
how to do the configuration, the name of a configuration page 
is put into [square brackets].
“Input Control” > [LPR] is an example of “Group” > [Configura-
tion Page].
The individual fields and buttons on a configuration page are 
usually identified by putting the field name or button name in 
“double quotes” unless the meaning is clear enough that no 
special signs are needed.
<Expressions within angled brackets> are used in two con-
texts.

• <key on the keyboard>

• <parameter name> which is to be replaced by a 
specific parameter value when you do your settings
Intermate LAN FS3  Print Server Administration Manual 15 
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1.4. Topics in This Book 
The rest of this book is divided into the following parts:

• Tools for Management and Configuration

• Initial Contact

• Configuring the “Basic” and “Permissions” Sub-Groups

• Configuring Services and Host-Sessions

• Information and Monitoring Possibilities

• Upgrades and Maintenance

• Appendices 
Each part has several chapters. The following information 
should help you to determine which chapters you need to use 
and whether there are special pre-requisites you need to fulfill 
before proceeding.

1.4.1. About Tools for Management and Configuration

• Chapter 2 “HTTP (Browser)” (page 26)
The Intermate LAN FS3 has an HTTP server in it which you 
attach to using a browser. Because the HTTP-based menu 
is the most comprehensive configuration tool, we use it as 
the framework for the whole manual. The HTTP-based 
menu also gives access to status information (described 
mainly in the chapters within “Management— Information 
and Monitoring Possibilities”, starting on page 105) and to 
“actions” not obtainable in any other way. 

• Chapter 3 “Configuration Using a Telnet Client” (page 32)
If there are very strong reasons for not using a Windows-
based configuration tool, you can use a Telnet client. The 
menu presented to a Telnet client is does not include status 
or actions (except for reboots), and the dialog is much more 
difficult to use than either the HTTP-based menu or the 
configuration tool presented in the following chapter. 
Intermate LAN FS3  Print Server Administration Manual 16 
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• Chapter 4 “The Intermate Management and 
Configuration Utility (IMCU)” (page 35)
This chapter covers how to install and use this powerful 
Windows-based utility as a supplementary tool for 
configuration and management. As a tool for configuring a 
single unit, the IMCU is especially useful in establishing 
initial contact. Most users will find other tools more useful 
for configuring the other parameters and options.

The IMCU is also a monitoring tool that can give you an 
overview over many different kinds of network devices and 
their network status (such as “not available”, “sleeping”, 
ready); for printers, you can also see “page count”. These 
possibilities are also introduced in Chapter 4, in the section 
“Device List / Available Agents” (page 39).
Finally, the IMCU can also be used for firmware upgrades 
and for copying configuration files from one unit to one or 
more other units (both in the chapters in “Upgrades and 
Maintenance”, starting on page 133, and in some of the 
appendices)

1.4.2. About Initial Contact
This part of the manual consists of one large chapter, 
Chapter 5 “IP Assignments for Initial Contact” (page 44). 
It contains comprehensive information on how to choose a 
method for assigning TCP/IP-related information (IP address, 
subnet mask, default gateway and host name)—and how to 
use the chosen method.  It is meant to help those whose situa-
tion cannot be easily handled with the information in Getting 
Started or the Quick Guide.
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1.4.3. About Configuring the “Basic” and “Permission” Sub-
Groups

The chapters in this part of the manual are organized accord-
ing to configuration pages in the HTTP-based menu.
The HTTP-based menu is divided into four groups:

• Actions

• Configurations

• Status

• Help
Within the “Configurations” group on the menu, there are a 
number of sub-groups. Each sub-group has a number of con-
figuration pages.  Each chapter title in [Square Brackets] indi-
cates a configuration page.
The order in which these pages are presented reflects a typical 
order for first time use. This may differ from the order on the 
HTTP menu, where the least frequently used pages are at the 
bottom of the “Configurations” group. 

The “Basic” sub-group has three configuration pages

• “[TCP/IP]” (page 58)
Besides IP address, subnet mask, default gateway, and host 
name, the [TCP/IP] page allows you to specify a WINS server 
to which this information will be sent. It also allows you to 
register the IP address of a DNS server on which the unit can 
look up the addresses of named servers on other configuration 
pages.

• “[General]” (page 60)
This configuration page includes a number of purely 
administrative parameters: What will you call the device, 
who is responsible for it and where it is located? 
It also includes a parameter to designate the “System Target 
Printer”, which is where information about the system is 
printed; and there is a parameter defining whether or not front 
panel messages should be enabled on that printer. 
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• “[Network]” (page 63)
This configuration page allows you to adjust “Speed / 
Duplex” (needed very rarely). In addition, it gives you the 
possibility of setting a “Local MAC address”.

The “Permissions” sub-group has two configuration pages

• “[Password Change]” (page 65)

• “[License Key]” (page 66)

1.4.4. About Configuring Services and Host-Sessions

Key Concepts, including NDO and HPO
The Intermate LAN FS3 allows you to print over a LAN to a 
designated printer from a number of different environments, 
using your choice of protocol. 
Input control. This is an umbrella term for protocols and print-
ing methods. In connection with the IBM Host Print Options 
(HPOs), there are a great many possible settings. The HPOs 
are AFP/IPDS, SCS TN5250E and SCS TN3270E.
Target printer. This is the physical printer. It is possible to buy 
a license key for the Network Destination Option (NDO). This 
allows you to use just one intelligent multi-protocol print server 
not only to control jobs to the local printer (in which the 
Intermate LAN FS3 is inserted) but also to send such jobs to 
up to four network destinations, where the printers are con-
nected with inexpensive basic LAN network-cards. In addition, 
the NDO provides load-balancing among the network destina-
tions.
Logical printer. This is a queue you can use in order to get 
pre- and post-job processing carried out, as well as defining 
string-substitutions within a job. A logical printer definition will 
always point to a target printer. 
Mapping the use of a target printer to a given service always 
requires using a logical printer definition.
The information in the chapter on“Processing Facilities” 
(page 69) explains how all these things fit together. Some of the 
information may seem abstract until you have tried your hand 
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at configuring, so you will probably return to this chapter many 
times.
The rest of the chapters within “Configuring Services and Host-
Session” are organized according to sub-groups of configura-
tion pages in the HTTP-based menu. Each title in [Square 
Brackets] indicates a configuration page.

“Output”
Because each input must point to an output, it is often conve-
nient to have output control configured before configuring 
input. Output has two dimensions—physical and logical. The 
“Output Control” sub-group has three pages, one for the physi-
cal dimension and two for the logical.

The Physical Dimension of Output: Target Printer(s) 
• “Network Destination Option” (page 87)

 
Skip this chapter if you only intend to use a local printer. 

This chapter tells you how to configure up to four 
network destinations. If you define and use a network 
destination without having a key, the print will be sent to 
the local printer. 

The network destination configurations are only a small 
part of setting up your Intermate LAN FS3 for NDO. The 
other things that need to be done are covered in the 
chapter on “Processing Facilities” (page 69)

The Logical Dimension of Output
The practical details of configuration are covered in

• “[Logical Printers 1-8]” (page 91)

• “[Substitution Strings]” (page 97).
The information needed to understand how these things work 
and how to use them is in the chapter on “Processing Facilities” 
(page 69). 
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“Input”
“Input” is the umbrella term for protocols and printing methods. 
The individual menu items for configuring input are found in the 
following five sub-groups on the browser menu:

• “Input Control” Sub-Group
“Services in “Input Control”” (page 99) covers the 
configuration of basic print services, which are protocol and 
methods requiring very little configuration: Raw Socket, 
LPR, FTP Print, and IPP. 

You can create up to four different definitions for Raw 
Socket by defining different TCP ports, and you can define 
up to eight LPR queues. So in all, you can configure 14 
services on these four configuration pages. 
You must, of course, also establish printer definitions which 
can use these services. How to do this is covered in Printing 
Environment Guides (or equivalent sections in the LAN FS3 
10/100 Ethernet User’s Guide (KL-008-2)).

• “TN5250E Option” Sub-Group is covered in the 
Printing Environment Guide for IBM OS/400 Systems.

• “TN3270E Option” Sub-Group is covered in the 
Printing Environment Guide for IBM Mainframe Hosts 
(or equivalent sections in the LAN FS3 10/100 Ethernet 
User’s Guide (KL-008-2)).

• “IPDS Option” Sub-Group is covered in Printing 
Environment Guides for four IBM environments (or 
equivalent sections in the LAN FS3 10/100 Ethernet 
User’s Guide (KL-008-2). These environments are 
listed in this manual in “TCP/IP Sessions, Services and 
Host-Sessions” (page 70).
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• “Novell Netware” Sub-Group, for support of 
IPX/SPX-based printing in NDS and Bindery modes, is 
covered in a Printing Environment Guide published in 
December 2001. 
This feature is only available on Intermate LAN FS3s 
sold before 4 January 2002, up to and including code 
level K92_1491.

1.4.5. About Information and Monitoring Possibilities
• “Printed Information Available” (page 106). 

“Print Main Status Pages” is the most important item.

• “Standard Monitoring Information” (page 108) covers all 
of the “Status” information you can get printed to the 
screen. “System Log” is the most important item. 
Note that you can get a hard copy of the System Log by 
printing the Main Status Pages.

• “Configurable Monitoring Tools” (page 112) tells you

•  How to enable/ create an IMCU agent 
•  How to enable and configure e-mail notification about 

what is happening with printer(s) served by any given 
Intermate LAN FS3.

• “Configure [SNMP]” (page 114) tells you how to enable 
and configure the Intermate LAN FS3 so that you can 
use a fully featured SNMP-based network 
management tool (such as HP OpenView) to manage 
many printers and monitor their activity in detail. 

• “The KPM Printer Utility (External Tool)” (page 128) gives 
tips on using this SNMP-based printer management 
tool from Kyocera-Mita.

• “Printer and Job Status via "Finger" (External Tool)” 
(page 131) tells you how to use the TCP/IP "Finger" 
command from a Windows management environment 
(NT or more advanced) or a UNIX/similar management 
enivironment.
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1.4.6. About Upgrades and Maintenance

Chapters on upgrades and maintenance
Starting on page page 134, this part of the manual tells you 
what kinds of things you can upgrade, explains the file-version 
naming- and numbering-system, and tells you how to proceed 
using three different methods. How to do bulk upgrades is also 
explained.

Maintenance-related items on the HTTP menu 

The "Actions" group on the HTTP menu has three items deal-
ing with maintenance:

• two kinds of reboots (for information on these, see 
“Activating New Values By Rebooting” (page 31) 

• restoring “All defaults” (for information on this, see 
“Overview of Types of Resets” (page 156)).

The “Links” group has two items, both of which are meant to 
help you keep your software and documentation up to date:

• “Contact Information” = Start Page 

• “Update/Utilities” = A direct link to a relevant web-site. 
If you want this opened in a new browser instance, hold 
down the <shift> key on your keyboard while clicking on 
the link.
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1.4.7. About the Appendices
The Appendices include reference information which is useful 
in several different contexts:

• “Customer Support” (page 160)— where and how to get 
it.

• “Technical Information” (page 161), including emission 
notices. 

• “Hardware Installation” (page 165)—included just in case 
you have lost the “Getting Started” brochure.

• “Information from LEDs and from the TEST Button” 
(page 166).

• “ASCII 7-bit Character Set: Decimal Values 32 - 126” 
(page 169)—these are the characters which are 
(almost) always sure to be printable; 33-122 are as 
good as 100% consistent in all kinds of code pages. 

• “String Syntax” (page 171) for pre-processing, post-
processing and string substitution.

• “Configuration Checklists” (page 173) for the whole 
configuration process and for the configuration of each 
single service or host-session. 
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2. HTTP (Browser)

2.1. Prerequisites
The following description assumes that you have already 
assigned an IP address to the Intermate LAN FS3. 
If the instructions in the brochure Getting Started or the on-
board Quick Guide haven’t met your needs, refer to Chapter 6 
“[TCP/IP]” (page 58) where there are supplementary explana-
tions and instructions for other methods.
You may have to set up an IP-route in order for the browser to be 
able to connect to the Intermate LAN FS3. If you are in doubt, 
ask your network administrator.
You need a browser which supports frame-sets and Java 
Script. 

2.2. How To Connect
Type the IP address for the Intermate LAN FS3 in the address 
field of the browser. For example: 

http://192.168.0.227
The browser’s Title Bar will show the print server name and 
brand followed by a hardware address in parentheses; the 
name of the browser usually concludes the information on the 
Title Bar. 
The hardware address shown will be the global MAC address 
(as described in “Hardware” (page 161) unless you choose to 
set a “local MAC Address” (as described in “Enable Local MAC 
Address” (page 63).
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2.3. Menu Items and Groups Before Login
The menu items are presented in the following four groups: 

• Actions

• Status

• Help

• Links

“Actions” 
In the starting menu, the only action listed is “login”. After your 
login, the content of “Actions” will change and a whole new 
group, “Configurations”, will be added.
The menu items in the next three groups remain constant and 
the groups remain placed at the bottom of the menu bar, so 
after login, you may need to scroll down to find them.

• “Status” includes several partial or specialized types of 
status which are displayed on screen. We will return to 
these in the chapter on Monitoring, starting with “The 
“Status” Group on the HTTP Menu” (page 108) 

• “Help” includes one item, the Quick Guide. 
The Quick Guide can alternatively be printed directly 
out from TEST Button by pressing it in when the unit is 
Ready (green LED is lit) and holding for more than 5 
seconds.

• “Links” includes two items:

•  [Contact info] is the same information that is displayed 
when you attach to the print server, before you login.

•  [Updates/Utilities] hops to the product-web site from 
which you can download firmware upgrades, utilities, 
and updated documentation.
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2.4. Login with User Name and Password
Choose “Actions > Login”.
Type in values for “User name” and “Password.” Both are 
case-sensitive.
If you are not a partner, there is only one possible “User name” 
(account), and this is admin.
The default password for the “admin” account is admin. 
It can be changed after a successful login.
Tip:  

If the Intermate LAN FS3 has been accessed before 
from the computer running the web browser, you 
should use the browser’s “Refresh” or equivalent 
button unless you are sure that the browser has been 
set not to use cached information

Tip:
If several different administrators and/or super-users 
are permitted to log on to the Intermate LAN FS3, it is 
possible that someone has changed the password and 
forgotten to tell you. So, if you are blocked after the first 
try, stop, and sort out who has changed the password 
before continuing.
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2.5. Menu Items and Groups After Login
After a successful login, the “Actions” group with its single 
“Login” menu item will be replaced with two main groups of 
items:

• “Actions”

• “Configurations”—as listed in “Topics in This Book” 
(page 16) 

“Actions” always give you the chance to “Cancel” or “Con-
firm” on an [<Action>] page before the system carries an action 
out. You can use “Actions” for the following things.

• Reboot There are two kinds of [Reboot], as explained 
below, in “Activating New Values By Rebooting” 
(page 31).

• “Print Main Status Pages”. These pages show 
configuration, i.e. all currently active settings for all 
parameters on the print server (except for certain 
configurations for the SCS HPOs). 

In addition, the Main Status Pages include information 
from the System Log which is filled from reboot to 
reboot.
It is a good idea to document each configuration change by 
printing the Main Status Pages.

• Print several different kinds of status pages for 5250 
(shown only if the TN5250E HPO is enabled).

• Stop traces started through an FTP session—
depending on which options—TN5250E, TN3270 
and/or IPDS, if any—have been activated.

• “Restore All Defaults.” This affects every single 
parameter, including identifying information, such as IP 
address, although some configurations for SCS HPOs 
are excepted. 
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2.6. How to Change Settings on Configuration Pages
When you choose a menu item for configuration, you will be 
presented with a page containing a number of parameters. In 
some cases, a configuration page can require scrolling down 
several screens. There are also some complex configurations 
which are presented as a sub-group of menu items, each with 
its own configuration page.
New settings for any given parameter are selected from a 
drop-down menu, selected by choosing a radio button, or 
typed into an input field. For many of the fields, you will find 
printed texts showing valid ranges. You may also find an “on-
mouse-over”/”walk-over” description with additional information 
on the parameter in question.
You can save some mouse-clicks by using the <Tab> key to 
move from one parameter to another.

At the bottom of each configuration page are three buttons:

• “Save & Cont.” validates and saves the new settings. 
You can save a mouse-click by using the < Enter> key 
on your keyboard instead.
If you type an invalid value in an input field, the 
configuration page will be replaced with a page telling with 
the following message

“Error in input field '<parameter name>
Press the Browser’s Back Button” 

When you do that, you will be presented with the 
configuration page again. You will probably have to look in 
the manual to correct your error.

• “Undo” restores the most recently saved settings. So if 
you have already saved your current work, you cannot 
use this button to move back to the previous values.

• “Factory Default” restores the default settings for the 
parameters on the configuration page in question—and 
only on that page. 

Saved settings are not activated until you reboot; the next sec-
tion explains how to do this. 
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If you are changing settings on more than one configuration 
page, it is usually a good idea to wait until you’re done with 
everything before rebooting.

2.7. Activating New Values By Rebooting
New values can be activated remotely by clicking one of the 
two “Reboot” items in the Main Group "Actions”.

• “Reboot (immediate)” reboots the Intermate LAN FS3 
immediately, terminating any current print job and. Jobs 
queued after a terminated job are not affected.

• “Reboot (controlled)” performs a delayed reboot. A 
reboot command is added to the job queue. The reboot 
is carried out when there are no more jobs known to the 
Intermate LAN FS3.

You can also reboot by re-cycling printer power. If you choose 
to do this, make sure that at least 10 seconds go by after the 
settings are saved before powering Off

2.8. Logout
Log out from the Intermate LAN FS3 by closing the browser 
window. 
Changing to another web address while running the same 
browser instance does not terminate the HTTP session.
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3. Configuration Using a Telnet Client

3.1. Connecting

Platform Prerequisites
Any Telnet client supporting NVT can be used to connect to the 
Intermate LAN FS3. This includes common platforms like Win-
dows, UNIX and AS/400. 
NVT is a minimum requirement for the client. The Intermate 
LAN FS3 defaults to NVT when connected with VT52 or 
VT100/ANSI. 

Setting Up Telnet Terminal Preferences
We recommend enabling Local Echo on the client in order to 
display the entries. The Buffer size should also be checked, as 
some values otherwise can disappear from the screen. A value 
of 50 or more is recommended.

Logging On
A line-based Telnet client connects like this.

c:\telnet 192.168.4.170 (Windows example)

===>telnet ’192.168.4.170’ (AS/400 example)
When a Telnet session is started, the Intermate LAN FS3 pre-
sents itself with the log-on screen. 
Type the user name: admin followed by <CR/Enter>.
Type the password followed by <CR/Enter>. The default pass-
word is admin. (You can change this from the menu, “Pass-
word”. The password is case-sensitive).
Once you are logged in, the “Main Menu” appears. 
You will be able to set everything except IP-address, Host-
name and license keys—but, as mentioned in the introduction 
to this guide, it is clumsy to use.
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3.2. Menu Items and Settings
“Main Menu”
For the most part, each item corresponds to a configuration 
page in the HTTP interface. For example:

1. General
2. Network.
...

The list ends with a display of the syntax for two kinds of save 
(S and C) and for exiting the Telnet session (Q). There is a tim-
eout function that breaks the connection to the Intermate LAN 
FS3 after about a minute of inactivity.
As indicated above, each item is numbered. 
Select an item by typing the number of the item to the prompt > 
and pressing the <Enter> key.

Configuration Menus
When you have chosen an item on the main menu, you will be 
presented with a sub-menu with a heading, a numbered list of 
parameters and the message “R. Return to main menu”. 
Examples of parameters in the sub-menu called “Raw Socket 
Menu”:

1. TCP Port 1 <9100>
2. Use Logical Printer 1 <PR0>
3. TCP Port 2 <9100> 
4. Use Logical Printer 2 <PR4>
...

As you can see in the example above, each parameter line fin-
ishes by showing the current setting in angled brackets. 
Select the parameter you want to change by typing in the num-
ber and pressing the <Enter> key.
You will then be shown the name of the parameter, the current 
setting, and information on possible values which are either 
chosen by item numbers or typed in. Pressing the <Enter> key 
finishes your data entry and returns you to the sub-menu (“pre-
vious menu”). 
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The sub-menu will show that you can use p (followed by 
<Enter>) to return to the previous menu, but sometimes enter-
ing p without first having entered a value can result in an error.
You can, however, always enter r (followed by <Enter>) to 
return to the Main Menu directly from the list of parameters on 
a configuration menu.
If the number of items does not fit on the screen, the text string 
Press <Return> is added to the default prompt. This means 
that <Enter> has to be pressed to view the next screen of 
items. 

3.3. Activating New Values By Rebooting
New settings are saved and activated by selecting one of the 
two possible reboots.
Note:

In the commands below, “interface” means the 
Intermate LAN FS3 print server

• "S. Save changes and reboot interface (immediate)” 
terminates any current print job and reboots the 
Intermate LAN FS3 immediately. Jobs queued after a 
terminated job are not affected. 

• The C. Save changes and reboot interface (controlled). 
This performs a delayed reboot. A reboot command is 
added to the job queue. The reboot is carried out when 
there are no more jobs known to the Intermate LAN 
FS3.
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4. The Intermate Management and 
Configuration Utility (IMCU) 

4.1. What the IMCU Is and How It Works
The Intermate Management and Configuration Utility (IMCU) is 
a web server based tool for detection, monitoring and configu-
ration of Intermate LAN devices in IP networks. 
The system consists of an HTTP-based Windows NT service, 
with software agents distributed across the network to commu-
nicate with print servers on each physical LAN. 
Management, installation of printers, installation and adminis-
tration of agents are all done from a Web-browser. This means 
that you can administer printers locally from the IMCU server - 
or from another network-attached PC - or even from a remote 
connection via the Internet. Thus, it is possible for the system, 
network or printer administrator to gain access to all printers 
from his or her home office. 
The agents detect devices using UDP, which means even print 
servers with no IP addresses can be monitored and config-
ured. This approach enables a network/printer administrator to 
configure devices with mis- or unconfigured IP settings any-
where in the network, using a standard web browser. This is 
why it can be used for the initial assignment of an IP address 
as described in the Getting Started brochure, the Quick Guide 
and the section on “Static IP Assignment Using the IMCU” 
(page 54) in this book.
Limited SNMP support is available for the detecting and moni-
toring third party or legacy Intermate print servers.
The IMCU is free. An installation file (P19-xxxx.EXE) is 
included on the Documentation and Utilities CD. New versions 
of the utility will be made available on our web site.
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4.2. This Chapter Covers Installation and Basic Use 
This chapter presents only how to install the IMCU and lists the 
kind of information you can monitor with it. 
Special uses of the IMCU are presented in other places in the 
documentation, directly in connection with the specific contexts 
in which it can be used. These uses are as follows:

• Configuration: 
•  Initial contact as explained in “Static IP Assignment 

Using the IMCU” (page 54).

•  Upgrading firmware, fonts and special configuration 
files (see “Upgrade Components” (page 134) and “Using 
the IMCU for Maintenance” (page 146)).      

• Management and editing of IDB (configuration) files for 
TN5250E. This feature was added (in beta) in 
P19_1491 (released 14 December 2001). See the 
Printing Environment Guide for IBM OS/400 Systems.
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4.3. Installation of the Various Elements
The IMCU server installs on Windows95/98/NT4.0/2000/XP as 
a service where it detects, monitors and upgrades print servers 
in large segmented IP networks. Note that TCP/IP must be 
installed. You can configure the kind of information you want 
displayed. 
An agent must be installed on a host on each IP segment hav-
ing devices you wish to monitor through the MCU server. An 
agent can reside on either a PC or on an Intermate LAN FS3 
print server.
Each Intermate LAN FS3 print server contains an IMCU client 
through which the agent can detect and configure first time IP 
settings, upgrade firmware and link to the print server’s own 
Web page. 

4.4. Establishing a Server
Remember that you must be logged on to the computer with a 
Windows NT account with administrative rights if you will be 
installing on Windows NT, Windows 2000 or Windows XP.
The IMCU server program is installed by copying the installa-
tion program to a PC running Windows and executing it. This 
installs the program files and starts the IMCU service.
The installation program will give you the possibility of installing 
a server, an agent, or both. It is a good idea to choose both, 
especially if the machine is on the segment where you will be 
installing the Intermate LAN FS3, because you will then be 
sure to have an agent that can detect the unit. 
During server installation, the program asks for a port number 
for the server (default is 80). Change the port number if 
another service already uses it. 
Tip:

You can check to see the ports your pc is listening to by 
using the command netstat -an.

Agent installation: Unless you have a very good reason for 
doing so, do not change the default port for the agent (8888).
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4.5. How to Log In and Out
Log in: 
Type the IP address of the PC running the server program in 
the address field of the web browser. 
Example—when the IMCU server is not on your own work sta-
tion.
http://192.168.0.38 (default port)
http://192.168.0.38:81 (alternative port)

If the IMCU server is on your own work station, use the loop-
back IP: 
http://127.0.0.1 (default port)
http://127.0.0.1:81 (alternative port)

When you are attached, you will be presented with the login 
dialog. There is only one possible user name: imcu. The 
default password is imcu, but it may have been changed by 
whoever it was that installed the IMCU server, so check with 
them. The password is case-sensitive. 
Log out from the IMCU server by closing the browser window. 
Changing to another web address while running the same 
browser instance does not terminate the HTTP session.
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4.6. Device List / Available Agents
The device list is your entry way to using the IMCU server. 
The screen is selected by clicking the "Device list" button 
in the top toolbar. You will be presented with a two col-
umn list showing “Agent” and “Devices”, however the 
“Devices” will be empty. 

 Use the “Expand” icon to bring forth a list of the 
devices discovered on that segment. 

Before proceeding to use the information on the list, use the 
"Refresh" icon to refresh the list; the browser’s “refresh” is not 
good enough.
The “column selection” button, allows you to tailor the 
device list to your wishes.
Figure 1. IMCU Column Selection.

A sample device list is shown on the next page.
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Figure 2. Device List
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4.7. Installing Agents
If there is an agent on the segment where your Intermate LAN 
FS3 is placed, you are ready to use the IMCU.
If you do not know whether someone in your network environ-
ment has already established an agent on the segment where 
your Intermate LAN FS3 is placed, log in to the IMCU server 
and use the Device List as described in the previous section. If 
the MAC address for your Intermate LAN FS3 does not show 
up on any of the agents, you need to install one. 
Unless you have a very good reason for doing so, do not 
change the default port for the agent (8888).
Note that it is possible to have several agents installed on the 
same physical network segment, but only one agent per host. 
The agent can be hosted on a pc or on an Intermate print 
server.

4.7.1. Remote Installation of an Agent from the IMCU server
If both the IMCU server and the pc which is to host the agent 
are running NT 4.0 or higher (Windows 2000, Windows XP), 
you can install an agent remotely.

Select Agent Management 
Select "New". Fill out the necessary information and 
then select  "Install".The necessary information is:

•  "IP address" of the pc to host the agent.
•  "Agent Name" (unless you are satisfied with the host IP 

address as the agent name). Try to choose a name 
which is meaningful for your administration.

•  The “Port” contains the port number the agent uses for 
communication with the IMCU server. Default is 8888. 
Do not change this without a very good reason.

•  You will probably not want to change the refresh or 
timeout intervals; check the on-line help if you are in 
doubt

After you select Install, you will be asked to enter a Windows 
NT account with administrative rights on the pc. You must 
enter Domain, Username, and Password. Click Install again. 
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4.7.2. Direct Installation of an Agent on a PC
If your setup does not fulfill the system requirement for remote 
installation, you will have to install an IMCU agent directly on a 
pc on the desired segment, for example your own work station. 
Perform this installation with the IMCU Installation Program, 
choosing “Agent Only”. 
Afterwards, return to the IMCU server. 

Select Agent Management 
Select "New". Fill out the necessary information and 
then select  "Install".The necessary information is:

•  "IP address" of the pc to host the agent.

•  "Agent Name" (unless you are satisfied with the host IP 
address as the agent name). Try to choose a name 
which is meaningful for your administration.

•  The “Port” contains the port number the agent uses for 
communication with the IMCU server. Default is 8888. 
Do not change this without a very good reason.

•  You will probably not want to change the refresh or 
timeout intervals; check the on-line help if you are in 
doubt

Finish by selecting "Add" (instead of "Install"). 

4.7.3. Troubleshooting Agent Installation on a PC
If the agent was not created, click the browser's "back" button 
and check the information typed in. A typical problem is the IP 
Address. If the address cannot be reached, it may be because 
an IP route needs to be set up. Other common mistakes are 
misspelling of the Domain, Username or Password. Ask your 
system administrator for further details. The IMCU server has 
quite a lot of on-line help available.

4.7.4. Embedded Agent on the Intermate LAN FS3
If you already have given an Intermate LAN FS3 (or another 
Intermate print server) an IP address using another method, 
you can activate the embedded agent on it. See “[IMCU Agent]” 
(page 112). 
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5. IP Assignments for Initial Contact

5.1. Introduction
You must change the IP address from the factory default 
(0.0.0.0). Additional IP settings that may need configuration 
are the Subnet Mask (default 255.255.255.0) and the Gateway 
address (default 0.0.0.0). Note that the Intermate LAN FS3 
supports classless routing. 
The methods available for setting the IP address vary depend-
ing on how your LAN environment is administered. When we 
discuss choosing a method, we are talking about the adminis-
tration, and not the print platforms you will be using. 
In fact, some of these platforms, notably IBM Mainframes 
(such as S/390) and Mid-Range (such as AS/400) have no 
management facilities of this type. This is no cause for con-
cern. Most LANs are administered from a Windows work sta-
tion, an OS/2 work station or a work station running UNIX, AIX 
or Novell Netware.
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5.2. Information Needed Before Starting
If you haven’t already done so, you must have the following 
information from (or cleared by) your network administrator:
* IP address - in the examples we will use 192.168.0.227
  (DHCP: You need a temporary static address)
* Network Mask - in the examples we will use 255.255.255.0
  (DCHP: Not necessary)
* Default Gateway (unless Auto-Routing (RIP) is used).
  (DCHP: Not necessary)
You also need to know the MAC address (= IEEE address = 
hardware adapter address) address of the unit. You can find 
the MAC address on the Main Status Pages. In the examples, 
we will use 00c0a200801e. 
Host Name: 
You must choose a host name which will identify the unit in the 
LAN environment.The unit will generate a default host name by 
attaching the last six digits from the MAC address to a prefix  
(lanfs3). 
You may use, modify, or totally replace this name. If you use 
the following guidelines, you will avoid conflicts caused by dif-
fering protocols found in today's typically mixed network envi-
ronments:

• Name length: minimum 2 and maximum 16 ASCII 
characters from the restricted list below.

• Do not use any tabs or character spaces (“blanks”)

• There is no distinction made between upper and lower 
case.

• You can make the name DNS qualified by adding a 
company domain name and a top domain, for example 
im00801e.mycompany.com. 

• Permissible characters: alpha (A-Z), numeric (digits 0-
9), minus sign (-), underscore (_) and period (.)—
subject to the following additional restrictions:
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•  Periods are only allowed when they serve to delimit 
components of DNS qualified names (“domain style 
names”). 

•  The first character must be alpha.
•  The last character must not be a minus sign, an 

underscore or a period.

Finally, if you will be using a method for initial contact 
which does not work across routers you must do the follow-
ing:
Find the IP address for your the PC or terminal from which you 
will be configuring the Intermate LAN FS3. 
Tip:

DOS commands for Windows users
winipcfg (Windows 95/98) or 
ipconfig (Windows NT 4.0, Windows 2000 or XP)

Determine whether or not your PC's or terminal’s IP address is on 
the same net-segment as the address chosen for the Intermate 
LAN FS3. 
If there is a router or a gateway between the two, then you must 
get them both on the same segment or choose a method for 
assigning an address to the unit which can work across a router 
with the help of an IP static route. 
How to find the group of settings called [TCP/IP]:

• Browser user: [TCP/IP] is in the "Basic” sub-group of 
the “Configurations” group. 

• Telnet user: TCP/IP is a point on the main menu. 
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5.3. Method Overview
• Delivery from a BOOTP server. Management 

environments: Novell Netware, AIX, UNIX, AIX, OS/2. 
Instructions for using BOOTP start on page 49.

• Delivery from an RARP server. Management 
environments: UNIX only. Instructions start on page 50. 
The RARP daemon does not work across routers or 
gateways.

•  Dynamic delivery from a DHCP server. This is mainly 
used to deliver IP addresses to PCs and work-stations, 
rather than to servers, but can be used to deliver an IP 
address to a print server such as the Intermate LAN 
FS3. 

If you are required by your network administration to let 
a DHCP server assign an address to the unit, you will 
need to use a static assignment method (see below) to 
make initial contact with it, and then enable DHCP 
afterwards. Instructions start on page 51.

• Static Assignment. Four methods are available for this: 

•   “ARP and PING” can be used in any of the LAN 
management environments mentioned, but should not 
be used if your system administrator requires the use of 
a BOOTP server or an RARP server. Instructions start 
on page 52. ARP does not work across routers or 
gateways. 

•  The Intermate Management and Configuration Utility 
(IMCU) can be used in environments running under a 
Windows operating system (Windows 95/98, NT 4.0, 
Windows 2000). Instructions start on page 54. 

Because the IMCU detects network devices at the 
hardware level you can set an IP address for a segment 
unreachable from your work station (as long as there is 
an agent on your own segment), do all or most of your 
configurations, and then move the Intermate LAN FS3 
to the segment containing that IP address. For 
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information on how to install the (IMCU), see “The 
Intermate Management and Configuration Utility (IMCU)” 
(page 35).

•  Using the printer’s front panel display, if there is one.
•  Addresses can be typed in to the input fields in the 

“Configuration [TCP/IP]” page. For obvious reasons, 
this cannot be used to establish initial contact with the 
print server

As default in the Intermate LAN FS3, RARP and BOOTP are 
enabled while DHCP is disabled. It is a good idea to make sure 
that only the method you use is enabled, while all other possi-
bilities are disabled, because the unit uses a fixed boot-
sequence. 
The order of look up is DHCP, BOOTP, and RARP. There will 
be a time-out in connection with each unsuccessful wait to be 
contacted by a server of IP addresses. 
After finding that there is no RARP server on the network, the 
unit will then check the current IP address. If it is 0.0.0.0, the 
system will wait for an ARP/PING mapping its MAC address to 
an IP address. If the current IP address is different from 
0.0.0.0, the system will use whatever address is stored cur-
rently. 

When you are finished establishing contact as explained 
below, you can continue with your configurations following the 
order of the chapters in this book. It is often a good idea to print 
the Main Status Pages to document your configurations.
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5.4. Assignment Using BOOTP
1 Connect the printer to the LAN and power it On.

2 Alter the [ /etc/bootptab ] file on the host. If this file does not 
exist on your system, it must be created manually using an 
ASCII file editor. Insert the following sequence in the 
[ /etc/bootptab ] file:
Syntax (written on a single line; it will rarely be possible to 
write the whole string on a single line, and you can usually 
use backslash at the end of each line to indicate that the 
definition continues)
<host name>: ht=<hardware type>: ha=<hardware 
address>: hn:      ip=<IP address>: sm=<subnet mask>: 
gw=<gateway field>
 Example:       
lanfs300801e: ht=ether: ha=00c0a200801e: hn: \      
ip=192.168.0.227: sm=255.255.255.0: gw=192.168.0.1

3 Save the [ /etc/bootptab ] file. 
Note:

On platforms other than OS/2, you may need to 
reinitialize the BOOTP-server every time you make 
changes to the      [ /etc/bootptab ] file in order to be 
sure the changes take immediate effect. 

For the AIX platform, however, it is sufficient to 
refresh the intetd subsystem. Syntax: 
refresh -s inetd

4 Connect and Login to the unit with a browser or Telnet 
client. 

5 Choose [TCP/IP]. 

6 Disable RARP and check to be sure that DHCP is still 
disabled. 
Note that the BOOTP delivers not only the IP address, but 
also the subnet mask and the default gateway.

7 Save your work and reboot. You can, of course, wait to 
reboot until finishing other configurations you want to make. 
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5.5. Assignment Using RARP
1 Connect the printer to the LAN and power it On.

2 Add the following lines to the [ /etc/ethers ] file or 
[  /etc/rarpd.cf  ] file: Note that the MAC address is written 
with colons : as separators between every two characters.

[ /etc/ethers ] file

<Hardware address> <Host name> (syntax)

00:c0:a2:00:80:1e fs3-a (example)
Or 

[  /etc/rarpd.cf  ] file

<IP address> <Hardware address> (syntax)

192.168.0.227 00:c0:a2:00:80:1e (example)
a Update your host table and alias name data 

bases.

b Start the RARP daemon, if it is not already 
running.
rarpd -a

3 Connect and Login to the unit with the tool of your choice. 
4 Choose [TCP/IP]. 

a Disable BOOTP and check to be sure that 
DHCP is still disabled.

b If it is not possible for Intermate LAN FS3 to 
obtain the mask from the network, you must 
type in a Subnet Mask. 

c If automatic routing (RIP) is not used in your 
environment, type in the Default Gateway.

5 Save your work and reboot. You can, of course, wait to 
reboot until finishing other configurations you want to make. 
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5.6. Assignment Using DHCP
DHCP can usually be enabled (“On”) via the printer's front 
panel display. If you prefer to enable DHCP remotely, follow 
the instructions below.

1 You must first assign an address statically using ARP and 
PING or the IMCU, as described in one of the sections 
below. When you continue from there, do the following:

2 Connect and Login to the unit with the tool of your choice.

3 Choose [TCP/IP].

a Disable BOOTP and RARP. Enable DHCP.

b If it is not possible for Intermate LAN FS3 to 
obtain the mask from the network, you must 
type in a Subnet Mask. 

c If automatic routing (RIP) is not used in your 
environment, type in the Default Gateway.

4 Save your work and reboot. You can, of course, wait to 
reboot until finishing other configurations you want to make. 
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5.7. Static IP Assignment Using “ARP and PING” 
1 Make sure that you own PC or terminal is on the same 

network segment as planned for the Intermate LAN FS3.

2 Power the printer On. 
3 Check the Main Status Pages to find the current IP address 

for your Intermate LAN FS3. You can print them by pressing 
the TEST Button for 2-3 seconds.
If the unit has already been assigned an IP address 
different from 0.0.0.0, you must re-set it in order to use the 
ARP command. For instructions, see “Restore Factory 
Defaults: TEST Button” (page 158).

4 Insert the relationship between the IP address and the 
hardware adapter (MAC) address in the ARP cache. The 
syntax varies according to your system environment. The 
examples below use the sample IP address 192.168.0.227.

From Windows environments
arp -s 192.168.0.227 00-c0-a2-00-80-1e

Tip:
Windows 95 does not add an entry in the ARP table if it 
is empty. So, if your ARP command doesn’t work, ping 
in another IP device in the network and then enter the 
ARP command again

From UNIX, AIX, OS/2
arp -s 192.168.0.227 00:c0:a2:00:80:1e

Tip:
If you wish to assign a host name to the Intermate LAN 
FS3, you can insert the relationship between the IP 
address and the host name in your system host table. 
For example: 192.168.0.227 fs3-a

Then the host name can be used instead of the IP 
address in the ARP command above.
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5 Ping the new IP address to store the address. Example:
ping 192.168.0.227

6 Pinging causes the Intermate LAN FS3 to reboot 
automatically. Wait for the reboot to finish.

7 Connect and Login to the unit with the tool of your choice 

a Choose [TCP/IP]

b Check to see that the BOOTP and RARP 
protocols are disabled (this should happen 
automatically when you use the ARP-PING 
method).

c If you will are only using the IP address as a 
stepping stone to DHCP, enable DHCP. 

Otherwise, set the Subnet Mask and the 
Gateway (if auto-rooting (RIP) is used, you can 
leave the Gateway as 0.0.0.0)

8 Save your work and reboot. You can, of course, wait to 
reboot until finishing other configurations you want to make. 
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5.8. Static IP Assignment Using the IMCU

Prerequisites
See “The Intermate Management and Configuration Utility 
(IMCU)” (page 35) for information on how to acquire, install and 
use this free utility program.
If your working place already uses the IMCU, check to be sure 
that the following things are in place.

• Find out what the IMCU server’s IP address is as well 
as what its port number has been set to (default is 80, 
but a network administrator or another printer 
administrator might have changed this to avoid 
colliding with another service). 

• The server must be running; you may have to ask 
another administrator or super-user about this.

• There must be an agent enabled on the net segment 
your Intermate LAN FS3 is connected to. If you are 
unsure about this, please consult “Installing Agents” 
(page 41).

Steps
1 Connect the printer to the LAN and power it On. 

2 Log in to the IMCU server with a web browser (as instructed 
in “How to Log In and Out” (page 38).

3 Use the “Device List” screen to find the agents known to the 
server. 

4 Select and expand the agent monitoring the IP segment the 
Intermate LAN FS3 is. This will give you a list of all the 
devices detected by the agent.

5 Refresh the list. If everything is as it should be, you should 
find a line for a device showing the MAC address for your 
Intermate LAN FS3. Double-click the MAC address.

6 This will open a “Device Configuration” window with the 
following fields:
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•  MAC Address 

•  Name (= Host Name - not changeable from within the 
IMCU; see instructions in “Host Name” (page 58))

•  Six settable parameters from the "TCP/IP" sub-group: 
three fields to fill out (IP Address; Subnet mask; 
Gateway) and three check-box fields: RARP, BOOTP 
and DHCP. 

7 Fill out the fields:

a IP address.

b If it is not possible for Intermate LAN FS3 to 
obtain the mask from the network, you must 
type in a Subnet Mask. 

c If automatic routing (RIP) is not used in your 
environment, type in the Default Gateway.

8 Make sure the BOOTP and RARP protocols are disabled 
(unchecked).

9 If you will are only using the IP address as a stepping stone 
to DHCP, enable DHCP.

10 Conclude your work by clicking "Save and reboot". You will 
receive a confirmation message.

If you will be continuing your configuration without delay, you 
have two choices.

Return to the “Device List” using the browser’s “back” button or 
the “Device List” icon. Find your Intermate LAN FS3 and dou-
ble-click on the “IP address” instead of the “MAC address”. 
This will open a new browser instance attached to the 
Intermate LAN FS3. Log in from there. This is usually the best 
choice.
The alternative is to actually use the IMCU as a complete con-
figuration tool. Choose “Advanced” from the “Device Configu-
ration” window. The resulting screen (after a login) contains 
links to all configuration pages, but the menu points have no 
grouping. And there are no links to status or action pages, help 
or contacts. This method should probably only be used if you 
have a lot of experience configuring the Intermate LAN FS3.
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5.9. .Static IP Assignment Using the Front Panel
Layouts of the keys on the printer vary. Consult your printer’s 
documentation for information on how to work the keys on the 
printer. The following instructions are meant to keep you from 
making serious errors. 

1 Make sure the printer with the LAN FS3 is disconnected 
from the LAN.

2 Power On the printer.

3 Using the keys on the printer, enter configuration mode. 
4 When you are finished setting the IP address, subnet mask 

and default gateway, be sure to save your work.

5 Wait at least 10 seconds, and then power the printer Off.

6 Reconnect the printer to the LAN by inserting the LAN drop 
cable into the LAN FS3. to the LAN.

7 Power the printer on.

8 You may want to confirm the results by printing a printer 
status page or a LANFS3 main status pages— press the 
TEST Button for 2-3 seconds after the Ready signal (green 
LED lit).
Intermate LAN FS3  Print Server Administration Manual 56 



CONFIGURING THE 
“BASIC” AND 

“PERMISSIONS” 
SUB-GROUPS
Intermate LAN FS3  Print Server Administration Manual 57 



[TCP/IP]: Mandatory IP-identifying information
6. [TCP/IP]
This chapter tells you about the individual parameters within 
the [TCP/IP] Configurations sub-group. This item is at the bot-
tom of the “Configuration > Basic” sub-group, but should be 
done before continuing with other configurations. Details on IP-
identifying Information are in “IP Assignments for Initial Contact” 
(page 44). 

6.1. Mandatory IP-identifying information

6.1.1. Host Name
The host name identifies the unit in the LAN environment. You 
may use, modify, or totally replace the default host name which 
will be generated by attaching the last six digits from the MAC 
address to a prefix such as IM or IMA (depending on the prod-
uct and model). 
See the syntactical requirements for an IP host name in “Information 
Needed Before Starting” (page 45)

6.1.2. Syntax for IP Address, Subnet Mask, and Default 
Gateway 

Default for each of these three parameters is 0.0.0.0
Syntax: Four address bytes separated by periods. 
Each address byte must be a number between 0 and 255; do 
not use leading zeros. Not all combinations of values will con-
stitute a valid address. Ask your system administrator if in 
doubt.
If Auto Routing (RIP) is used in your environment, you can 
leave the Default Gateway set to 0.0.0.0.

6.1.3. Enable DHCP, BOOTP, RARP—or none of these
Please consult the instructions in “IP Assignments for Initial Con-
tact” (page 44).
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6.2. Optional Settings

6.2.1. DNS Server for Look-Ups 
There are a number of configurations in which you can either 
use a name or an IP, for example to register a mail server, a 
TN5250E server, or network printers. 
If you want to use names, make sure that they can be looked 
up on a DNS server, and enter the IP of this DNS server here. 
Syntax: Four address bytes separated by periods.
Each address byte must be a number in the interval [0..255]. 
Do not use leading zeros. Default is 0.0.0.0

6.2.2. WINS Server
If you enter WINS Server address, the contents of Hostname 
and IP Address for the unit are sent to the WINS server at start 
up.
Syntax: Four address bytes separated by periods.
Each address byte must be a number between 0 and 255. Do 
not use leading zeros. Default is 0.0.0.0
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7. [General]
Each section in this chapter discusses a single parameter on 
the [General] configuration page in the “Configurations > 
Basic” sub-group. In order to aid understanding, the parame-
ters are presented in a slightly different order than the order on 
the configuration page.

7.1. Administrative Parameters 

7.1.1. Model
The [General] page leads in by displaying the print server’s 
model. This text cannot be edited through the usual menu; 
OEM partners, please contact our support department.

7.1.2. SysAdmin contact
Maximum 47 ASCII characters within the decimal range 32-
126 (see the table on page 169). Use this parameter to indicate 
a contact person or department for local support and trouble-
shooting for the Intermate LAN FS3. The contact name will be 
printed on E-mail and SNMP notifications, should you imple-
ment them.

7.1.3. Device’s location
Maximum 47 ASCII characters within the decimal range 32-
126 (see the table on page 169). Use this parameter to specify 
the physical location of the printer in which the Intermate LAN 
FS3 is installed. 
The device location will be printed on e-mail notifications, 
should you implement them.

7.1.4. Device Name 
Maximum 47 ASCII characters within the decimal range 32-
126 (see the table on page 169). 
The device name will be printed on e-mail notifications, should 
you implement them. 
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Important:
Do not confuse this name with the Host Name (see 
“Prerequisites” (page 54) and “Host Name” (page 58)).

7.2. System Target Printer
The System Target Printer has the following special functions. 

• When you choose “Actions” > [Print Main Status Pages] 
the output is directed to the System Target Printer.

• When you an output goes through Logical Printer 0 
(PR0), the physical output is always directed to the 
System Target Printer.

By default, the System Target Printer is the Local Printer, that 
is the printer to which the Intermate LAN FS3 is installed.
If you have a license key and have enabled the Network Desti-
nation Option (NDO), you can—but do not have to—choose 
another printer instead (Netw1, Netw2, Netw3, or Netw4) as 
System Target. 
If you choose a Netw# printer from the list without having a 
license key including rights to NDO, the print server will use 
Local as System Target Printer and write information about the 
mismatch to the System Log (““Status > System Log”” 
(page 110)). 
If you need help in understanding the concepts of Target Print-
ers (physical printers) and Logical Printers, please consult the 
chapter on “Processing Facilities” (page 69).
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7.3. Enable Front Panel Messages (on System Target 
Printer)

This parameter was introduced in K92_1071. It enables and 
disables the PJL commands used for writing messages in the 
front panel of the System Target Printer 
The messages in question describe what kind of processing is 
going on, for example “IPDS Printing”, “IPP Printing”, and so 
on. 

 Values Comments

Yes Enable front panel messages. If you have chosen this and the 
System Target Printer does not support PJL, messages will come 
out in your print job.

No * Disable front panel messages.
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8. [Network]

Each section in this chapter discusses a single parameter on 
the [Network] configuration page in the “Configurations > 
Basic” sub-group.

8.1. Media speed and duplex 
Do not change this value without consulting with the responsi-
ble system administrator.

8.2. Enable Local MAC Address
This parameter was introduced starting with K92_1071. It 
allows you to override the factory default Global IEEE-
assigned MAC address delivered with the Intermate LAN FS3 
for administration of devices according to a corporate strategy. 
Default is No.
Important:

When you enable a Local MAC address, this will be shown in 
the browser’s title bar and on the IMCU. Please note that the 
Local MAC address cannot be used when ordering a license 
keys for options.

The Main Status Pages (“Actions > Print Main Status Pages”—
or use the TEST Button) and Code Revisions Page (“Status > 
Code Revisions”) will show both addresses.

Values Comments

Auto * Strongly recommended!

10Mbit/sec. half duplex Force 10 Mbit/sec.

100Mbit/sec. half duplex Force 100 Mbit/sec.
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8.3. Local MAC Address
If you enable the use of a Local MAC Address, choose the 
address with care. Connecting devices with identical Local MAC 
addresses to the network may result in faulty network behaviour 
that can affect other devices in the network.
In addition, setting a Local MAC Address outside the range 
indicated below can result in difficulties which can only be 
resolved by restoring the factory defaults.

Values Comments

[40.00.00.00.00.00 - 
7F.FF.FF.FF.FF.FF]

Hex value. Use upper case letters ONLY. 
Six dot-separated number groups with two digits in each.
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9. Configuring Permissions
The “Permissions” sub-group is located at the bottom of the 
“Configurations” group and contains two configuration pages.

9.1. [Password Change]

Select User Name
This field will always show the user name admin (unless you 
are an OEM-user). 

Enter New Password
The default password for the admin account is admin.
A password contains maximum 13 characters and is case-sen-
sitive. You can use any ASCII characters within the decimal 
range 32-126 (see the table on page 169).

Re-enter Password
In order to set a new password, the text string must be con-
firmed using the re-enter box.
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9.2. [License Key]
Many of our units are delivered with pre-configured license 
keys. If this is the case, the license key number will be written 
on a label on the back plate of the unit and you need not use 
this configuration page.
Otherwise, you must purchase and enter an appropriate soft-
ware License Key in order to use Host Print options (HPO) in 
production mode or NDO option with or without an HPO option.
A key includes one or more options. The following list is an 
example; please consult your point of purchase for the correct 
part numbers:

• Network Destination (NDO)

• HPO for 3270/5250 SCS/TNe

• HPO for 3270/5250 SCS/TNe plus NDO 

• HPO for AFP/IPDS (including TNe) 

• HPO for AFP/IPDS (including TNe) plus NDO 

9.2.1. Ordering a key
License Keys are ordered from your point of purchase. If you 
bought the Intermate LAN FS3 from LCI Intermate A/S directly, 
you can order a key by fax or e-mail (sales@intermate.com). 
You must provide the below minimum information.

1 The Global MAC Address (also known as the IEEE address 
or the hardware adapter address). 

2 The options you wish to purchase.

3 Contact information including your name and organisation.
You can find the MAC address on the Main Status Pages (use 
the TEST Button or choose “Actions” > [Print Main Status 
Pages]—as well as on Code Revision (displayed on the 
screen; you can choose it from the “Status” group on the HTTP 
menu).
The web title bar will always show a MAC Address, for exam-
ple as follows
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Intermate LAN FS3 Print Server (00C01200F256) - Microsoft Internet Explorer

If the Local Mac Address option has been enabled (as 
explained in “Enable Local MAC Address” (page 63), the 
browser title bar will show this local address. This can not be 
used for the key. Use the Main Status Pages or Code Revision 
to find the Global MAC Address.

9.2.2. License Key Entry
The license key you order will be generated uniquely for the 
MAC address for your Intermate LAN FS3. The key consists of 
four digit groups separated by periods. 
When it is generated, each group in the key will always have 3 
digits. For example: 167.045.093.281
When you enter the key in the data entry field labelled “License 
Key”, you must not use any leading zeroes. For example: 
167.45.93.281.
Note that you will be overwriting the factory default value of 
255.255.255.255.
When the key is saved and activated, the value shown in the 
data entry field will again be 255.255.255.255. But you will 
be able to see what you have activated by looking just above 
the data entry field where a value for “Current Product Level” 
will be displayed. 
Entering any value other than your key will disable the features 
activated by any previously entered key. Features including a 
test mode will revert to test mode the next time the Intermate 
LAN FS3 boots up.
Once you have a license key, it is helpful to write it on a label 
on the back panel of the unit.
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10. Processing Facilities

10.1. Introduction
In order to configure the Intermate LAN FS3 optimally, you 
should familiarize yourself with how it processes print jobs. 
This chapter covers the following topics:

• “TCP/IP Sessions, Services and Host-Sessions” 
(page 70)

• “Physical Printers = Target Printers” (page 74)

• ““Use Logical Printer”” (page 75)

• “Processing Layers” (page 76)

• “Logical Printers” (page 77)

• “Data Manipulation in the Logical Printer Layer” (page 79)

• ““Load Balancing Pools” (NDO only)” (page 84)

• “Working with NDO Load Balancing Pools and Data 
Manipulation” (page 85)

There are some sections within several topics which you can skip 
if you don’t use NDO and/or if you don’t use the data manipulation 
facilities in the logical printer layer. Each of these sections are 
marked at the beginning of the section.
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10.2. TCP/IP Sessions, Services and Host-Sessions
A single Intermate LAN FS3 can handle up to 32 simultaneous 
TCP/IP sessions. The following tables list the services and 
host-sessions available.
Figure 3. Services

In connection with the Host Print Options (HPOs), the services 
are called host-sessions, because what our service does is to 
initiate a session on the IBM host. These are listed below.

Input Type/ Protocol Services

IPP Internet Print Protocol. one service

Raw Socket TCP Port # # = 1, 2, 3, or 4 (maximum 4 services in all).

Configurable: printer port number, for example 9100

LPR queue # # = 1, 2, 3, 4, 5, 6, 7, or 8 (maximum 8 configurable services 
in all)

Configurable: queue name and queue type.
There are 4 additional pre-configured queues.

FTP print one service

Novell Netware 
Rprint/Pserver (Bindery 
& NDS), or through the 
NDPS Gateway

One service.

Configurable: IPX/SPX frame. Operating Mode, Connection 
Mode, and other “Netware” options. SAP 

Availability: IPX/SPX-based Novell service is only available 
on Intermate LAN FS3s sold before 4 January 2002, up to 
and including code level K92_1491.

All information on this service is found in a separate Printing 
Environment Manual (published December 2001) available 
on our web-site.
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Figure 4. HPO: SCS TN5250E Host Sessions

TN5250E for SCS/DCA L2. This HPO emulates IBM 3812-01 printers

Up to 4 different host-sessions.

SCS Features Supported:

- SCS and SCS/DCA L2 data streams

- 3 bin paper input and duplex

- COR/APO

- IBM font selection

- IBM virtual ASSCII transparency

- Multiple Code pages and box drawing

- Full OfficeVision 400 support

- Euro-enabled

A large number of network and processing options are configurable. See the Printing 
Environment Guide for IBM OS/400 Systems. 

Note: If you have not purchased and enabled a key. SCS print will be in test mode.
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Figure 5. HPO: SCS TN3270E Host Session

TN3270E for SCS. This HPO emulates IBM 3287 printers in LU1 mode

One host-session on IBM Mainframe host (typically S/390 or S/370).

SCS Features Supported:

- SCS (LU1) data stream

- GDDM

-COR/APO

- EAB

- APL2

- RPQs for 3287, 3268 and 4214

- Structured fields and query

- Draft, NLQ and LQ modes

- 3 bin paper input

- Euro-enabled.

A large number of network and processing options are configurable. See the Printing 
Environment Guide for IBM Mainframe Hosts when it comes on our web-site; until 
then, consult the equivalent sections in the LAN FS3 10/100 Ethernet User’s Guide 
(KL-008-2).

Note: If you have not purchased and enabled a key, SCS print will be in test mode
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Figure 6. HPO: IPDS Host Session

IPDS emulation (using the PPD/PPR protocol) - one host-session

A large number of network and processing options are configurable. 

IBM printers emulated

- 3812-x, - 3816

- 3912/16, - 3112/16

- 4028

IPDS Features Supported

• All resident fonts functional equivalent to IBM 3816,

4028, 3916 and 3116 standard fonts. Euro enabled.

• Duplex printing

• DIN-A3 and Ledger (11x17) support

• Data Towers:

- Text

- IM Image

- IO Image

- Graphics

- Bar Code

• Resource Towers:

- Page Segment

- Overlay

- Loaded Font

- IPDS Exception

Available for the following platforms:

- IBM Main-frame (IBM MVS with TCP/P and PSF V2.2)

- IBM OS/400 Systems with PSF/400

- AIX (V3.2.4 or higher with PSF/6000)

- OS/2 Systems (OS/2 with PSF/2, IBM Warp Connect)

A printing environment manual exists—or is on the way—for each of these platforms. 

Note: If you have not purchased and enabled a key, print will be in test mode. 
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10.3. Physical Printers = Target Printers

10.3.1. Local Printer
The printer in which the Intermate LAN FS3 is inserted is known 
as the “local” printer. 

10.3.2. Network Printers Using “NDO”
If you have a license key for the Network Destination Option 
(NDO), you can configure and use up to four network destina-
tions. 
The printers you choose for this should support the status 
information nodes defined in the Printer MIB (RFC1759) and 
some host information nodes of the Host Resources MIB 
(RFC1518). 
Printers without this support can be used, but no useful moni-
toring information will be provided in the “Target Printer Infor-
mation” provided by the Intermate LAN FS3. (Target Printer 
Information is described on page 109.)

10.3.3. The “System Target Printer” 
The system target printer is the physical printer on which status 
information and help can be printed from the HTTP-based 
menu. By default this is the local printer. If you have a license 
key for the Network Destination Option (NDO), and do your 
NDO configuration, you can specify a printer at a network des-
tination instead.
The system target printer has another special feature which we 
will come back to in the discussion of logical printers.
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10.4. “Use Logical Printer”
If you do not use NDO, the only use you will have for config-
urable logical printers (numbers 1-8 on the table below) is to 
define data manipulation as explained below in “Processing 
Layers” (page 76) and “The Configurable Logical Printers 1-8” 
(page 77).
If you do use NDO, logical printers can also play a role in 
directing a job to the target printer.
The logical printer definition is the medium through which a 
printer at a network destination (Netw#) can be chosen. The 
parameter is called “Use Logical Printer” and it must be defined 
for every service and host session you will be using.

Use Logical Printer Directs output to:

PR0* Logical Printer 0 No manipulating of data. 

Users of the Network Destination Option (NDO) 
please note: 

The target printer will be the printer designated 
as “System Target Printer” on the [General] 
configuration page in the “Configurations > 
Basic” sub-group.

PR1, PR2, PR3, PR4
PR5, PR6, PR7, PR8

Logical Printer 1 
Logical Printer 2
Logical Printer 3
Logical Printer 4
Logical Printer 5
Logical Printer 6
Logical Printer 7
Logical Printer 8

Select one of these queues to have data 
manipulated by a logical printer definition. 

Users of the Network Destination Option (NDO) 
please note:

The definition of a logical printer includes 
choice of target printer.
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10.5. Processing Layers
Print jobs sent to the printer are processed in several layers by 
the Intermate LAN FS3 before the actual printing occurs. 
Figure 7. Processing layers. Read from left to right.

When the job starts, a print handler is started as an instance of 
the print server, i.e. the Intermate LAN FS3. A process is 
started which “carries” the job through the various layers. The 
protocol from the print client to the print handler is the one 
specified in the service. 
The print handler asks the printer request system to give the 
job exclusive rights to use the specified target printer. It makes 
sure that the job waits until its turn in the print queue and keeps 
the following jobs at bay until it is their turn. 
HPO stands for Host Print Option. The HPO emulator is used 
when the service is an IPDS, TN5250E, or TN3270E host-ses-
sion. 
When you configure a given service Intermate LAN FS3, you 
must always tell it which logical printer to use. In turn, each log-
ical printer redirects the job to a target printer (or to one pool of 
target printers (enabled under NDO)) 

Print Client

Printer request
system

Logical
Printer

Target Printer
(physical)

Print Handler

HPO
Emulator

Service Protocol

Input Control Output Control
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10.6. Logical Printers

10.6.1. PR0
Logical printer zero (PR0) has three special properties:

• It has no data-manipulation capacity. That is, it can not 
do any pre- or post-job processing and cannot handle 
substitution strings. 

• It is always the default setting for where a given service 
will send jobs.

• It always prints to the system target printer. It is only by 
changing the definition of the system target printer 
(page 61) that you can change the final destination of 
jobs that go through PR0.

10.6.2. The Configurable Logical Printers 1-8
You can configure 8 different logical printers, known as PR1 to 
and including PR8. Following are the parameters you can set 
for each logical printer you want to use.

Physical printer 
Each definition of a logical printer must include information on 
the physical printer it will carry the job to. This will be either a 
target printer or a pool. Several logical printers can point to the 
same target printer or to the same pool.
In addition you can choose one or more types of data manipu-
lation (“pass-processing”) as described below:

Pre- and Post-Job Processing 
(“String Before and String After”)
Pre- and post-job processing (“string before” and “string after”) 
enable intelligent selection of advanced finishing options from 
applications that do not natively support these features. 
This kind of processing is especially useful in connection with 
digital copiers and other types of “Multi-Function Devices” with 
combined printing and copying facilities.
“String before” could, for example, select a paper cassette, 
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select an output bin, set the page orientation, and so on. 
“String after” would typically revoke the effects of “string 
before”, but can also be used to provoke a page feed at the 
end of the job, so that there is a separator page, and so on.
Each logical printer can have one “string before” and/or one 
“string after”. Each string can contain many commands.

b) String Substitution
A “substitution string” actually consists of a pair (a set) of 
strings, one “input” and one “output”. You can define up to16 
substitution strings, assigning any of them to any of the 8 logi-
cal printers. This is typically done in order to print characters 
from another code table, translate characters to escape 
sequences, call macros and so on.
Each logical printer can use any—all— or none of the substitu-
tion strings you have configured. 

How Strings Are Written
You must write substitution strings as well as “string before” 
and “string after” in a printer control language such as HP PCL 
or Kyocera Prescribe. Detailed information about this is found 
in “String Before and String After” (page 95), “[Substitution 
Strings]” (page 97), and “String Syntax” (page 171).
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10.7. Data Manipulation in the Logical Printer Layer
Note:

Skip Section 10.7 if you will not be working with data 
manipulation in the logical printer layer.

10.7.1. Examples of Logical Printer Definitions
If you work in a complex environment where you really want to 
get the most of each multi-protocol print server, it would be a 
good idea to make a table showing the kinds of capabilities you 
want to use in each logical printer.
Figure 8 is an example of how to do this. It shows a set of defi-
nitions for logical printers, using every day descriptions instead 
of a printer control language. Even if you only need a few logi-
cal printers, it can be inspiring to consider the examples of how 
the different processing capabilities can be combined. There 
are two assumptions made in this example:

a Sixteen sets of input and output strings have 
been (or will be) defined on the [Substitution 
Strings] page (refer to the chapter on 
“[Substitution Strings]” (page 97) when you need 
to do an actual configuration). 
Each “substitution string” has a number. To tell 
a logical printer that it should use a substitution 
string, you just list the number in the logical 
printer definition, just as it is shown on the table 
below.

b The Network Destination Option (NDO) is not 
enabled, so the only target printer available is 
“local”. Later in this chapter we will see what 
happens when network printers are added.
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Figure 8.  Mixed, complex environment but only one printer  

Logical 
Printer

Pre-Processing (String Before)  Post-Processing (String After) Substitution 
Strings

0 (zero) not possible not possible not possible

1 input tray 5, output bin 4, sort and staple restore these settings to what they 
were before

none

2 input tray 5, output bin 4, sort and staple restore these settings to what they 
were before

1, 5, 10, 14

3 input tray 5, output bin 4, sort and staple restore these settings to what they 
were before

3, 5, 8, 9, 14, 
15, 16

4 input tray 5, output bin3, do not sort form feed, print a message on the 
separator sheet then restore these 
settings to printer’s default

1, 5, 10, 14

5 use any input tray available that can print in 
a landscape orientation, output bin 3, sort

restore these settings to what they 
were before

none

6 change language code table restore the previous language code 
table

2, 4, 5, 11, 12, 
13, 14, 16

7 wait for manual feed none 1, 2, 4, 5, 6, 7

8 none form feed, print a message on the 
separator sheet

none
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10.7.2. Processing Flows—Examples
By knowing the order in which processing occur, you can prevent 
and troubleshoot problems which might arise from combining dif-
ferent kinds of processing.
PR0 always uses a “one-step” process. This is illustrated in 
Figure 9 and in Figure 10, where the service protocol requires 
an HPO emulation (in this case SCS TN3270E). Note that the 
IPDS HPO is placed in the printer, and not in the HPO Emulator 
layer.
Figure 9. “PR0” (Logical Printer 0)

Print Client

Printer request
system

Logical
Printer Target Printer

Print Handler

HPO
Emulator

1
     PR0
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Figure 10. SCS TN3270 through “PR0” (Logical Printer 0)

As soon as a logical printer other than PR0 is involved, the 
requester must now keep track of three steps, even though it 
might not use all three of them.
Figure 11 shows a job sent off with a service configured to use 
a logical printer which uses pre-and post-processing, but no 
substitution strings. For this example, we assume that the logi-
cal printer involved is PR5 (as shown in the examples listed in 
Figure 8).

Print Client

Printer request
system

Logical
Printer Target Printer

Print Handler

HPO
Emulator

1
     PR0TN3270E
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Figure 11. “PR5” configured for string before and string after 

Finally, let us imagine an example using an HPO emulation (in 
this case SCS TN5250E) and PR2 as exemplified in Figure 8. 
The example below in Figure 12 is a bit unusual, because our 
TN5250 E gives so many configuration possibilities within the 
data stream. The point is, however, that the Intermate LAN 
FS3 can handle any combination. 
Figure 12.  5250E through “PR2”.
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10.8. “Load Balancing Pools” (NDO only)
When you implement NDO, you have the possibility of placing 
several of the physical, target printers into a common load bal-
ancing pool.   Load balancing intelligently routes incoming jobs 
to the first free or least loaded printer in a pool. 
Important:
Printers in a pool must have identical processing features, and 
the safest bet is to only pool identical printers.
Let us assume that the physical printers “local” (0), Netw1 (1), 
and Netw2 (2) are identical (printer type A) and that Netw3 (3) 
and Netw4 (4) are identical (printer type B). This means that 
you can potentially define the following load balancing pools, 
and note that (for example), 3,4 is not the same definition as 
4,3:
0, 1, 2
1, 2, 0
0, 2, 1
1, 0, 2
2, 1, 0
2, 0, 1
0, 1
1, 0
0, 2
2, 0
1, 2
2, 1
3, 4
4, 3
You must use logical printers to define a pool. The practical 
details of this are explained in “Load Balancing Pool” (page 93), 
where principles for ordering your printer number entries are 
also explained.
If you do not use logical printers for data manipulation, your are 
finished with this chapter. If you do use logical printers for data 
manipulation you might want to continue with the next section 
in this chapter.
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10.9. Working with NDO Load Balancing Pools and 
Data Manipulation

Note: Skip Section 10.9 if you do not use data 
manipulation in logical printers.

You need to remember the other functions you want performed 
by that logical printer when you define a pool as the target for a 
logical printer. So let us return to the practice of making tables 
to get an overview of configurations. By adding a column to the 
example in Figure 8, Figure 13 below shows an example of how 
each logical printers can be set up utilize pooling. 
Figure 13. Complex example: logical printer configurations

Logical 
Printer

Load Balancing 
Pool

Pre-Processing  Post-Processing Substitution 
Strings

0 (zero) 4, 3 not possible not possible not possible

1 4, 3 input tray 5, output 
bin 4, sort and staple

restore these settings to what 
they were before

none

2 [not a pool: Target 
= PR0]

input tray 5, output 
bin 4, sort and staple

restore these settings to what 
they were before

1, 5, 10, 14

3 1, 0, 2 input tray 5, output 
bin 4, sort and staple

restore these settings to what 
they were before

3, 5, 8, 9, 14, 
15, 16

4 2, 0 input tray 5, output 
bin3, do not sort

form feed, print a message on the 
separator sheet then restore 
these settings to printer’s default

1, 5, 10, 14

5 [not a pool: Target 
= PR4]

use any input tray 
available that can 
print in a landscape 
orientation, output bin 
3, sort

restore these settings to what 
they were before

none

6 1, 0, 2 change language 
code table

restore the previous language 
code table

2, 4, 5, 11, 12, 
13, 14, 16

7 [not a pool: Target 
= PR3

wait for manual feed none 1, 2, 3, 4, 5, 6, 
7

8 2, 0, 1 none form feed, print a message on the 
separator sheet

none
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This is a pretty complex example to illustrate what is possible. 
Don’t try to fully understand the details shown. When you start 
configuring your own systems, the details will make sense to 
you.
To be complete in your planning, you must consider which 
types of input will be sent to which logical printer. The final 
example below shows this; at the same time, it reflects a more 
realistic situation entailing less complicated use of pre-pro-
cessing, post-processing and string substitution than in the 
previous figures. 
Figure 14. Simpler example: services and logical printers 

Types of 
input 
configured 
to... 

Logical 
Printer

Load 
Balancin
g Pool]

Pre-Processing 
(String Before)

 Post-Processing 
(String After)

Substitution 
Strings

FTP, Raw-4, 
LPR-5 

0 (zero) 0, 1 not possible not possible not possible

SCS 5250E 1 3, 4 none none none

SCS 5250E 2 0, 1, 2 none none none

SCS 5250E, 
LPR-7

3 3, 4 none form feed, print a message 
on the separator sheet

none

SCS 5250E, 
LPR-8

4  0, 1, 2 none form feed, print a message 
on the separator sheet 

none

IPP, 
ThinPrint, 
Raw-2, LPR-
2, LPR-6

5 4, 3 none form feed, print a message 
on the separator sheet

1, 5, 10, 14

LPR-3, Raw-3 6 0, 1 change language 
code table

restore the previous 
language code table

2, 4, 5, 11, 12, 
13, 14, 16

LPR-4 7 3, 4 wait for manual 
feed

none 1, 2, 3, 4, 5, 6, 
7

LPR-1, Raw-1 8 0, 1, 2, none form feed, print a message 
on the separator sheet

none
Intermate LAN FS3  Print Server Administration Manual 86 



Network Destination Option: Requirements
11. Network Destination Option
The menu item is called "Network Printers (NDO)" and configu-
ration page is called [Network Printers (NDO)].

11.1. Requirements
You can configure and save the configurations for up to four 
“Network Target Printers”, also known as “Network Destina-
tions”. You will not be prevented from saving NDO configura-
tions if you have no NDO key. However, all printed output will 
be routed to the local printer. In addition, an error will be written 
to the System Log (see ““Status > System Log”” (page 110)).

11.1.1. Recommended Features for Network Target Printers
The Intermate LAN FS3 retrieves printer status information 
from the Network Target Printer through SNMP. For this to 
function properly, a network printer must support the status 
information nodes defined in the Printer MIB (RFC1759) and 
some host information nodes of the Host Resources MIB 
(RFC1518). 
If the target printer lacks these features, printer halts (Paper 
jam, Paper out, Off-line etc.) at a Network Target Printer will be 
interpreted by the Intermate LAN FS3 as “busy” until a user 
has fixed the problem.

11.1.2. Configurations for Each “Network Printer #”
The path to the configuration page covering all 4 printers is:
“Configurations > Output Control > Network Printers (NDO)”   
Each set of parameters is labelled Network Printer #  and lines 
are used to separate the sets from each other. Parameters:

•  “Hostname”

• “Print Method”

• “Raw Socket TCP Port”

• or “Printer LPR Queue Name” and “LPR Count Byte 
(MB)”.
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11.2. Hostname
This parameter specifies the address of the of a network target 
printer (or rather, the address of its LAN connection). 

Default is blank. If the field is left blank, the particular network 
destination is regarded as disabled. 

11.3. Print Method 
“Netw# Print Method” concerns output, and brings the job from 
the logical printer to a network target printer. 
The choice of Raw Socket or LPR for this print method is inde-
pendent of the print protocol for a service (“Input Control” sub-
group), where the protocol brings the job as far as the logical 
printer.

Values Comments

IP address 

or

4 dot-separated bytes, each within the range [0..255]

DNS registered name Maximum 47 ASCII characters. It is best to observer the 
restrictions described for host names on page 58. The name must 
be registered on the DNS server specified in [TCP/IP Settings] > 
“DNS Server IP Address” (page 59)

Values Comments

Raw Socket * Establish a Raw Socket (port 9100; Reverse Telnet) with the 
network printer you are configuring.

If Raw Socket is chosen, you must also fill out Raw Socket TCP 
port number.

LPR Print to an LPD Daemon. This is a more complex protocol which 
should only be used if network printer you are configuring can not 
handle Raw Socket.

If LPR is chosen, you must also fill out LPR Queue Name and LPR 
Count Byte.
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11.4. Raw Socket TCP Port 
This parameter specifies the Raw Socket TCP port number 
used on the target printer at destination #. It will be ignored if 
you choose LPR as “Netw# Print Method”. 

Value Comments

9100* [1024..65500] Refer to the manual for the printer to determine available Raw Socket 
port numbers.
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11.5. Printer LPR Queue Name
This parameter contains the name of the LPR queue name 
used on the target printer at destination #. It will be ignored if 
you choose Raw Socket as “Netw# Print Method.” 

Use a logic for naming queues that fits well into your environ-
ment. The configuration page shows a default name LPQ1 in 
each of the four possible slots, and you need not change these 
names, given that each network destination has a different 
host name.

11.6. LPR Count Byte (MB)
LPR is a spooling protocol, which normally requires a count 
byte to indicate the size of the job to the LPD daemon. 
Because the Intermate LAN FS3 does not have the ability to 
spool the job in order to verify the total length, it is necessary to 
specify a “Receive Data File” byte count in MBytes for the LPR 
job. Valid values are in the interval [0..2147], and 2147 is 
default. 
In order to choose the correct value for the network destination 
in question, you need to investigate how the LPD Daemon is 
integrated on the printer which will be targeted at that destina-
tion. 
According to the LPR/LPD RFC1179 a byte count of zero will 
indicate an infinite size. This is for example accepted for the 
LPD integration in Windows NT.
LPD Daemons not accepting a count byte of zero may accept 
a byte count larger than the job (i.e. a client disconnect before 
the byte count is reached). Defining a byte count value larger 
than the largest expected LPR print job may therefore have the 
same effect as a byte count of zero.

Values Comments

<qname> Maximum 8 ASCII characters. It is best to observer the restrictions 
described for host names on page 58. 
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12. [Logical Printers 1-8]

12.1. Introduction
All eight configurable logical printers are set up on a single 
configuration page in the HTTP interface. Each set of parame-
ters is labelled "Logical Printer #" and lines are used to sepa-
rate the sets from each other.
For each configurable logical printer PR1 - PR8 there are five 
fields: one mandatory, one conditionally mandatory, and three 
optional fields. 

Target Printer (1-2 mandatory fields)
You must choose a target printer from the drop-down list for 
that field. 
If you use the NDO and choose “pool” instead of a single tar-
get, you must also define the pool in the field following. Printers 
in a pool should all function identically (as described in““Load 
Balancing Pools” (NDO only)” (page 84)).

Up to 3 optional fields for data manipulation
• String Before

• String After

• String Substitutions 

Order of fields within each set
On the configuration page, the optional fields appear first in the 
set of parameters defining a logical printer, while the target 
printer definition comes last.
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12.2. Target Printer
This parameter specifies the destination of the printed output 
to be used in connection with the logical printer you are config-
uring.
If you are not using NDO, the only possibility is to keep the 
default which is Local (0).
If you are using NDO, you can choose among six possibilities 
for a given logical printer:

• Local(0)

• Netw1(1)

• Netw2(2)

• Netw3(3)

• Netw4(4)

• Pool
"Local" is also referred to as the local port and refers to the 
KUIO port of the Kyocera printer in wihich the LAN FS3 is 
installed.
If you choose a Network Destination which has not been 
defined in “Network Destination Option” (page 87), and then 
send a job to the logical printer in question, the job will be dis-
carded and an error message will appear in the System Log 
(see ““Status > System Log”” (page 110)). The same thing will 
happen if you have defined a Network Destination, but have no 
NDO license key installed.
If you choose "pool", you must also fill in the next field in the 
block defining the logical printer you are configuring.
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12.3. Load Balancing Pool
This parameter is only used when the target printer for a logical 
printer definition is set to “pool”. It specifies the already defined 
network target printers which are to be included in the load bal-
ancing pool. 
If you choose "pool" as the target printer, but leave the "load 
balancing pool" field blank,  print jobs sent to the logical printer 
in question will be discarded and a message will be generated 
in the System Log.
The values to enter from the set [0, 1, 2, 3, 4] refer to the val-
ues in round brackets on the pull-down menu for “Target 
Printer” (page 92). You can enter any combination, assuming 
that the combination you choose only includes printers with 
fully equivalent functionality.
Listed network destinations not having a valid IP host address 
configured will be excluded from the pool. 
If none of the network destinations listed in the pool have been 
configured with a valid IP address, the local port (0) will be 
used.

Determining the order of values to enter
The order in which the target printer numbers are listed deter-
mines priorities. In other words, the order of the list determines 
the order in which the Intermate LAN FS3 tests to see where a 
job should be sent.
Prioritizing is only activated in situations where two or more tar-
get printers in the load balancing pool are idle. 
If all output ports in the load balancing pool are busy, a new 
incoming job will be destined to the queue in the pool that first 
becomes idle regardless of the priority.’
It is often a good idea to put the least heavily used printers at 
the start of the list.
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See ““Load Balancing Pools” (NDO only)” (page 84) and “Working 
with NDO Load Balancing Pools and Data Manipulation” 
(page 85) for examples of what you need to think about when 
you plan pools.

 Example Comments

4,0,3,2 Network Destination 4 has the highest priority, followed by the Local Port and 
Network Destination 3. Network Destination 1is not included in the pool.
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12.4. String Before and String After 
The data manipulation provided in "string before" and "string 
after" for a given logical printer make it possible to send printer 
control commands before and after the actual data stream in 
the print job. Examples of how these manipulations are used 
are found in the chapter on “Processing Facilities” (page 69).
Each logical printer can have one "string before" and one 
"string after". The maximum number of "Encoded Bytes" you 
can use in “String Before” and “String After” depends on the 
identification number of the logical printer involved as shown 
below. See the appendix on “String Syntax” (page 171) for an 
explanation of "Encoded Bytes".
Figure 15. Maximum number of Encoded Bytes

In K92_1071 the number of characters in "String After" was 
reduced from 100 to 50 for logical printers 2-8 in order to 
increase the number of characters available for "String Before".  
"String After" definitions made under previous releases using 
more than 50 characters will be truncated to 50 characters 
when upgrading. .

Maximum number of encoded Bytes in PR# String... 

Logical 
Printer

... Before ... After

1 500 100

2 500 50

3 500 50

4 500 50

5 200 50

6 200 50

7 200 50

8 200 50
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12.5. String Substitutions
As mentioned in “The Configurable Logical Printers 1-8” page 77, 
it is possible to set up a logical printer to do string substitution. 
The strings are defined in the next configuration page in the 
"Output Control" sub-group (“[Substitution Strings]” (page 97).
If you want the logical printer you are configuring to use one or 
more of these strings, enter all the relevant string numbers in 
the "String Substitutions" field for the logical printer you are 
configuring. The numbers you enter must be separated by 
commas.
This is trivial. What is challenging is planning the content of 
your substitution strings and entering them in a meaningful 
order. This is covered in the section on “Planning” (page 98) in 
the “[Substitution Strings]” chapter.
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13. [Substitution Strings]

13.1. “Input String #” and “Output String#”
The [Substitution Strings] configuration page consists of 32 
fields.
They are paired as follows:
Input String 1
Output String 1
...
...
Input String 16
Output String 16
So you can define up to 16 substitutions; think of them as 16 
string sets (pairs).
The syntactical rules for input strings and output strings are the 
same as for “String Before” and “String After” (as described in 
“[Logical Printers 1-8]” (page 91)). 
Each input string or output string can fill up to 100 encoded 
Bytes (see “Basic Rules and Encoded Bytes” (page 171) in the 
appendix on string syntax).
String sets entered in the [Substitution Strings] configuration 
page have no effect until you set up a logical print which will 
use one or more of them (“String Before and String After” 
(page 95)).
When your chosen logical printer is configured to use a given 
string set, the data stream in a job directed to that logical 
printer will be inspected. If there is a string exactly matching 
“Input String #”, it will be removed and be replaced with “Output 
String #” in the same set.
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13.2. Planning 
As shown in “[Logical Printers 1-8]” (page 91), it is easy to tell a 
logical printer to use one or more (even all) of the string pairs 
defined in [Substitution Strings]. 
What is difficult is the planning when you want more than one 
substitution string to be used. If there is any overlap in the con-
tent of the input strings, you must carefully control the order in 
which you enter the string # in the “String Substitutions” field 
for the logical printer in question. 
Example: You want to use the following substitution strings in 
logical printer x, where the input strings encode like this:
Input String 1: trs98
Input String 5: trs98563
Input String 8: 98
Input String 8 is a subset of Input String 1, which in turn is a 
subset of Input String 5. 
If you want to be sure that everything is interpreted correctly, 
you must order your entries in the “String Substitutions” field 
like this:
8,1,5
So, if you will be using substitution strings, you should define 
what they are to accomplish and number each pair of input and 
output strings, and examine them in detail. Do this on paper 
before you start entering data in the Intermate LAN FS3. 
For inspiration, see the examples in “Data Manipulation in the 
Logical Printer Layer” (page 79) and “Working with NDO Load 
Balancing Pools and Data Manipulation” (page 85)
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14. Services in “Input Control” 
This chapter covers configurations for Raw Socket, LPR, FTP 
Print, and IPP.

14.1. Raw Socket 
You can configure up to four Raw Socket services.
All four are configured on the same configuration page.
Each configuration requires you to set two parameters, where 
# is the number of a given Raw Socket service.

1 Which TCP Port to use.

Type in a value for “TCP Port #”. Default is 9100. 

Raw Socket is traditionally assigned to printer port 9100, 
and is sometimes even called the “port 9100 protocol” (or 
the Reverse Telnet Protocol). You can, however, choose 
any value within the range [1024.. 65500], given that the 
value chosen is consistent with a printer definition used to 
print Raw Socket via the Intermate LAN FS3.

2 Where to direct the output:

Choose a value for “Use Logical Printer #”. Default is PR0.
The other possibilities are PR1 - PR8, inclusive.
 
If you need help to understand how output is directed, 
please consult the chapter on “Processing Facilities”, 
especially the sections ““Use Logical Printer”” (page 75) and 
“The Configurable Logical Printers 1-8” (page 77).

If you will only be using one Raw Socket service, leave all the 
fields in their default.
If you want to use more than one Raw Socket service, you 
need to plan how you will differentiate them from each other. 
The (host) environment from which you send jobs can only find 
its way to processing in the Intermate LAN FS3 via the port 
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number which is part of any given printer definition. 
This means that if you want to use the special processing facil-
ities in a logical printer, you must use a different port number to 
point to each of the logical printers you want to use. 
For example 

Remember to “Save & Cont.” and then “Reboot” to activate.

TCP Port # Port Designation Logical Printer

1 9100 PR0

2 9101 PR4

3 9102 PR5

4 9103 PR8
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14.2. LPR Print Queues (LPD Protocol)
The Intermate LAN FS3 supports up to 12 LPR queues. 
Eight of them are configurable while four are pre-configured.
Each queue is identified by the following three parameters:

a name

b queue type
c where to direct the output (as described under 

Point 2 on p.99).
The name must, of course, be known to the (host) environ-
ment(s) from which you will send jobs. 
On the configuration page, the “name” fields for the config-
urable queues have been filled out with defaults LPQ1, .... , 
LPQ8. If you want to change the queue name, note that it must 
consist of maximum 8 ASCII characters. Check the documen-
tation for your host systems for syntactical restrictions, or 
observe the restrictions described on page 58.
Each queue type either sends the data stream through without 
any conversion (“binary”), or converts the data stream to 
ASCII. In addition, the queue type determines whether or not a 
form feed will be used after the data stream is finished. So, 
there are four types in all, as shown in the table below:

Remember to “Save & Cont.” and then “Reboot” to activate.

The four pre-configured LPR queues look like this (see the 
table on the next page):

Type

Binary transfer, no conversion.

Binary plus form feed after * This is the default type if no queue name match is found

ASCII transfer (LF => LF-CR conversion).

ASCII plus form feed after
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You will probably not need to define any other queues to point 
to PR0, but may well want to configure one or more queues to 
point to other logical printers. 

The four pre-configured LPR queues:

Queue Name Type Output is directed to

PAR_B binary PR0

PAR_BF binary plus form feed PR0

PAR_A ASCII PR0

PAR_AF ASCII plus form feed PR0
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14.3. FTP Print
All you need to do is choose where you want the output of FTP 
jobs directed (as described under Point 2 on p.99)— and, of 
course, check to be sure that the logical printer points to the 
desired physical printer.
Before code level K92_1071, it was only possible to direct out-
put to PR0.
Remember to “Save & Cont.” and then “Reboot” to activate.
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14.4. IPP Print (Internet Printing Protocol)
IPP print, version 1.0 and 1.1, is supported with all mandatory 
features and services plus some optional ones.
IPP support allows the user to print across the internet and 
intranet to a printer with an accessible IP address.
IPP retrieves information on this printer’s capabilities and fea-
tures such as color, duplex, paper sizes, etc. The user has full 
control over print jobs (print objects) and can even cancel print 
jobs after they have been submitted. 
All you need to do is choose where you want the output of IPP 
jobs directed (as described under Point 2 on p.99)— and, of 
course, check to be sure that the logical printer points to the 
desired physical printer.
Remember to “Save & Cont.” and then “Reboot” to activate.

Client-side configuration
The IPP server can be reached on port 631 and the print ser-
vice is called “printer”. See the Printing Environment Guide for 
Windows for a sample configuration (after 28 February 2002). 
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15. Printed Information Available

15.1. Main Status Pages
The Main Status Pages make it possible for you to see all of 
the settings you have configured and can be invaluable as a 
reference. The structure of the information follows that of the 
menu you will see if you use a browser for configuration. 
Besides listing the current configurations, the Main Status 
Pages also include information on firmware levels and every-
thing that has been written to the System Log since the last 
reboot.
Initiate the print remotely by using “Actions” > [Print Main Sta-
tus Pages] on the HTTP menu; the HTTP menu is the only 
configuration and management tool that can do this. Alterna-
tively, you can use the TEST Button to get your print. See 
“TEST Button to Print Main Status Pages or Quick Guide” 
(page 168) in the appendices. 
Regardless of your choice—HTTP menu or TEST Button—the 
printout is always directed to the printer you have set to be 
System Target Printer (page 61). 
If the System Target Printer is the local printer, pressing the 
printer’s own “status” button or choosing to print the status 
from an operator panel will sometimes print the print server’s 
Main Status Pages after the printer’s own status pages are fin-
ished printing; this depends on the printer model
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15.2. .Other Printouts in the “Actions” Group
Users of TN5250E are provided with three extra kinds of 
printed configuration information. 

• SCS5250 IDB Status

• SCS5250 IDB Dump

• SCS5250 Font Dump

15.3. “Help” > [Quick Guide]
This is the same mini-manual that you can get printed out by 
using the TEST Button (as explained in the Getting Started 
brochure and in this guide, “TEST Button to Print Main Status 
Pages or Quick Guide” (page 168)). The txt-file is also available 
on our web-site and on the CD-ROM.
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16. Standard Monitoring Information

16.1. The “Status” Group on the HTTP Menu
Items on the “Status” group always result in information dis-
played to the screen. If you want to print it out, activate the 
main window by clicking somewhere on it and then use your 
browser’s “print” button.
If you have the optional “serial software downloading cable 
RJ45 - DB9” and a tool such as HyperTerminal, you can watch 
error messages, warnings and many other kinds of messages 
(for example in connection with upgrades) in real time. The 
Intermate LAN FS3 has its own serial I/O (console) port.
The following items are always available in the “Status” group:

• “Target Printer Info” (see page 109)—only applicable to 
printers at network destinations.

• “System Log” (see page 110). This contains mostly 
warnings and error messages, and these are described 
on page 111.

• “Code Revisions”. This will give you very detailed 
information which you will rarely need unless (for 
example) you are doing some troubleshooting with a 
supporter.

• “Printer”—that is the printer in which the Intermate LAN 
FS3 is inserted, the local printer. This status information 
is limited to telling you if the printer is “Ready” or in a 
particular error condition, such as paper jam, out of 
paper, etc.

The following items are only available in the “Status” group if 
relevant settings have been enabled at various places in the 
system:

• WINS

• IPX/SPX (discontinued in Intermate LAN FS3 after 
code level K92_1491)
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• TN5250E

• TN3270E

16.2. “Status > Target Printer Info”
Here is an example of Target Printer Info where one network 
printer has been defined and activated
Target Name: Netw1 
Target Communication Protocol: Network - RAW Socket
Printer Name: FS-3700+ 
Bidirectional Support: Yes 
Printer Status: READY 
Display Message: [Unavailable] 
Online Status: Online 
Job Boundary Page Counter: 0 
Total Page Counter: 57239
Duplex Print: Off 
Job Queue: No Job in Queue 

Note: The information on status for a network printer / 
network destination is only available and reliable if 
the printer at this network destination supports 
SNMP-based queries (see “Recommended Features 
for Network Target Printers” (page 87), 
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16.3. “Status > System Log”
The System Log lives from reboot to reboot. 
When you choose “Status >System Log”, the current informa-
tion is displayed on screen, labelled Status [System Log].
Note that the current information in the System Log is also 
included in the print of the Main Status Pages (see page 106).
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16.4. Warnings and Error Messages
Here are the kinds of warnings and error messages that can 
appear, mostly in the System Log, but sometimes flashed real-
time and directly on the screen.

16.4.1. Messages requiring you to seek help from a point of 
purchase

• “Unsafe adapter address detected (MAC). Probably not 
set yet” This indicates a serous problem Contact your 
point of purchase.

• License key messages:
•  “No license key found for ThinPrint”

•  “At least one logical printer is set up to use NDO. Sorry, 
no license key found. Using LOCAL.”

•  “System target set up to use NDO. Sorry, no license 
key found. Using LOCAL.”

16.4.2. Messages about things you can fix yourself
• “Load Balancing Pool used. Found no valid targets in 

pool.” 

• Target printer not ready yet, or invalid configured”

• “Failed to connect to target printer”

• “LPR target refused job”

• “Used a logical printer with no valid target 
configuration”

• When you are working with a configuration page and 
type an invalid value in an input field, the configuration 
page will be replaced with a page telling with the 
following message:
“Error in input field '<parameter name>. Press the 
Browser’s Back Button” 

• You may also see information on forced value changes, 
which may or may not require action on your part.
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17. Configurable Monitoring Tools

17.1. [IMCU Agent]
If you already have given an Intermate LAN FS3 an IP 
address, you can activate the embedded agent on it. 
Log in to the Intermate LAN FS3.
Browser users: choose the [IMCU Agent] configuration page in 
the “Status Monitoring” sub-group. 
Telnet users: choose the IMCU menu item. 
Enable the function and enter the port number. Default is 8888. 
Do not change this without a very good reason.
For more information on the IMCU, see “The Intermate Manage-
ment and Configuration Utility (IMCU)” (page 35).
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17.2. [E-Mail Notification]
Choose [E-Mail Notification] in the “Status Monitoring” sub-
group.

Some of the identifying information on the mail comes from 
mandatory settings, such as IP address and host name, or 
from system information, such as code level. The rest comes 
from what is entered on the [General] Configuration page. 
The sender is identified with the following syntax:

<Device Name> <Print Server Hostname> 
<<administrator’s mail address>> 
Example:
Accounting fs3-a
<jjj@mycompany.com> 

The mail will also show “System Admin. Contact” and “Device 
Location”.

Parameter Default 
Setting

Comments

Enable E-Mail Notification No Enable the function using the radio button.

SMTP Server Address >Blank< Enter the IP address of the mail server.Alternatively you can 
enter a name if this name is on the DNS server registered on 
the [TCP/IP] configuration page in the “Basic” sub-group.

Mail Receiver Address >Blank< This can be anyone who might be expected to respond to the 
message.

Administrator E-mail Address >Blank< This address will be presented on a mail as the sender. 

On what occasions should an autogenerated notification message be sent?:

Notify on ’Off-line’ Yes

When you enable E-Mail Notification, all of the “Notify 
on....” parameters will be enabled by default. You can 
disable them by changing the radio button choice from 
“Yes” to “No

Notify on ’Out of Paper’ Yes

Notify on ’Paper Jam’ Yes

Notify on ’Cover Open’ Yes

Notify on ’Toner Low’ Yes

Notify on ’Printer Error’ Yes

Notify on ’Power Off’ Yes
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18. Configure [SNMP]

18.1. Introduction and Pre-Requisites
The Intermate LAN FS3 can be configured so that you can use 
SNMP-based network tools to manage many printers and 
monitor their activity in detail. 
Several software programs exist that provide an easy to use 
interface for network management via SNMP. One of the most 
popular is the node management program HP OpenView 
which is used in this manual (version D.03.02 for Windows). 
The operations and settings referred to should be easily recog-
nizable in case another program is used. However, it is always 
a good idea to refer to the documentation supplied with your 
SNMP software for help and details.

Code level
Configuration and management via SNMP requires Main Code 
K92_1071 or higher

MIB
You will need a Private MIB (Message Information Base) file. 
This is available from Kyocera-Mita.Store the file in a logical 
location, for example in a directory named after your printer or 
on a floppy disk.
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18.2. Set Up a Connection With Your SNMP Tool

To set up a connection
1 Start HP OpenView.
2 Create an icon for the printer to be configured. Open the 

Add menu by choosing “Edit > Add..” in the menus.

Set the type of connection to “Computer” and choose the 
“Printer Server” icon for representation. 

Drop the icon in the submap window by left-clicking on it 
and dragging it.
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When the icon is placed you are asked to describe the 
“Printer Server.”

3 Type in a suitable printer “Name”, the “Network Address” 
(IP address) and MAC Address of the Intermate LAN FS3. 

The MAC address must be entered without spaces or 
points. You can find the IP- and MAC-addresses on the 
(Main) Status Pages which you can print either from the 
TEST Button (see “TEST Button to Print Main Status Pages 
or Quick Guide” (page 168)) or from the HTTP menu 
(“Action” > [Print Main Status Pages”).

When you are done, click the “OK” button and close the 
“Add” menu.

4 Check the new connection by pinging the Intermate LAN 
FS3. 
Do this by right-clicking the icon in the “Submap” window 
and choosing “Ping” This opens the “Ping” window. Press 
the “Start” button and wait for a reply. If the connection is 
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okay, a message starting with the words “Reply from...” 
appears. If no message appears check the connection, 
Intermate LAN FS3 and printer.

5 Once the connection has been set up you must save it. Do 
this by choosing “File > Save As...”.
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18.3. Edit “Variables”
With HP OpenView queries are used to show the contents of 
variables (corresponding to our parameters).

To define a query and edit variables
1 Start HP OpenView and choose the connection you wish to 

work with.

2 On the main screen choose “Control > SNMP Manager... > 
Define Query...”.

3 Choose the variables you wish to view from the “Available” 
list and add them with the “Add -->” button to the “Selected” 
list. 
Press the “Perform” button when done. This opens a 
window showing the contents of the chosen variables.

4 Edit the variables. Leave the dialogue box by clicking 
“Close”.
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18.4. Load and Edit “Options” (Parameters)
Intermate LAN FS3 parameters can be edited with SNMP 
management program after the Private MIB has been added to 
the MIB database.

To add the Private MIB
1 Start HP OpenView and choose the connection you wish to 

work with.

2 In the main screen choose the “Control > SNMP Manager. 
> Manage Database.”. This opens the Manage Database 
window.

3 Choose the file named rfc1213.mib in the list of available 
MIB files and press the “Add->” button.

4 Add the Private MIB file by pressing the “Import...” button. 
Locate and choose the file and press the “OK” button.

5 Back in the Manage Database window select the Private 
MIB file and click the “Add->” button.

6 Click the “Close” button.
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To edit the Intermate LAN FS3 parameters
7 On the HP OpenView main screen choose “Control > 

SNMP Manager... > Define Query...”. This opens the 
dialogue box for defining queries. Note that the parameters 
will be called “variables”.

8 Select the variables to view and add them to the “Selected” 
list. The Intermate LAN FS3-"option” variables are found by 
clicking “iso > org > dod > internet > private > enterprises > 
intermate > imaPs1”. This brings up a list of all available 
“option groups” (each corresponding to a configuration 
page). Double-clicking an “option group” name accesses 
the variables contained in that group. Select the variables 
or groups to be viewed. Use the “Add ->” button to add 
single variables or entire groups to the list. 
Finish by pressing the “Perform” button.

Example: The figure below shows the variables found in 
the “General” option group (= the parameters found on the 
[General] configuration page in the print server’s HTML 
dialog).

9 Edit the variables.
10 Click the “Close” button to finish.

11 Power the printer Off and On (but wait 10 seconds after 
saving the “options” before powering Off).
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12 Ping the Intermate LAN FS3 to verify that it is ready. This 
can be done by right-clicking the connection in the submap 
window and choosing “Ping.”. Press the “Start” button to 
ping a single time. Repeat the pinging until the Intermate 
LAN FS3 replies.

Tip:
The pinging can be set to be performed continuously by 
checking the Continuous Operation feature in the 
Option menu.
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18.5. Traps
Traps are used to monitor the printer and to report errors and 
attempts of unauthorized user access.
The kinds of traps which are generated are controlled on the 
Intermate LAN FS3’s [SNMP] configuration page using the 
parameters Enable Authentication Traps (Default setting: No) 
and Enable SNMP Printer Traps (Default setting: No).
The receivers of the traps are specified with Trap Target 
(Default setting: >Blank<). The receiver’s community is set 
with Trap Community (Default setting: public).
The traps that can be generated based on printer events are 
listed below.
Figure 16. SNMP Printer Trap Numbers

In addition to these come traps generated by unauthorized 
attempts of viewing or editing options.

To set up traps
1 Start HP OpenView and choose the connection you wish to 

work with.

2 On the main screen, choose “Options > Customize Traps”.

Printer trap no. Printer event Parameter Default Setting

1 Printer ready - -

4 Printer off-line Trap on ’Off-line’ Yes

32 Out of paper Trap on ’Out of Paper’ Yes

128 Cover open Trap on ’Cover Open’ Yes

512 Paper jam Trap on ’Paper Jam’ Yes

1024 Toner low Trap on ’Toner Low’ Yes

8192 Undefined error Trap on ’Printer Error’ Yes
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3 In the box just opened, select the “Device Class Name” 
called 1.3.6.1.4.1.1527 with the enterprise number 
1.3.6.1.4.1.1527.

Note:
It is NOT necessary to add any extra device classes in 
order to receive traps from the Intermate LAN FS3.

4 Press the “Edit...” button in the lower part of the dialogue 
box.
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5 Edit the fields as shown below and click “OK”.

6 Close the “Customize Trap Alarms” box.
7 Log on to the Intermate LAN FS3.

8 Choose “Configurations > Status Monitoring” > [SNMP] to 
set the parameters you want. 

Parameter Default Setting Comments

Monitor Community public

Control Community public

Trap Community public Set this to a value other than public to 
control who should receive traps.

Trap Target >Blank< The receivers of traps are specified by their 
IP addresses. IP addresses must be 
entered with the ASCII character one as 
lead-in, e.g. 1192.168.4.185 

For Novell Netware under IPX/SPX 

Use the IPX/SPX address. 
IPX/SPX addresses be entered with the 
ASCII character zero as lead-in, e.g. 
00000000400c0a2050729
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9 Reboot the Intermate LAN FS3.

Enable Authentication Traps No Set this to Yes to enable traps on attempts 
of unauthorised access.

Enable SNMP Printer Traps No Set this to Yes to enable traps on printer 
errors.

Trap on ’Off-line’ Yes -

Trap on ’Out of Paper’ Yes -

Trap on ’Paper Jam’ Yes -

Trap on ’Cover Open’ Yes -

Trap on ’Toner Low’ Yes -

Trap on ’Printer Error’ Yes -

Parameter Default Setting Comments
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18.6. Using and Viewing Traps 
Now that everything is set up, whenever a printer error occurs, 
a trap is sent and the icon for the established connection on 
the main screen turns red. The traps can be tested by generat-
ing some printer events. Try for example to open the cover and 
then view the trap.

1 Right click the connection icon on the main screen and 
choose “Alarms..”

2 Choose a connection in the Alarm Log by clicking on it 
once.

3 Click the “More Info..” button to view more details on the 
trap received.

Look up the number in Figure 16 “SNMP Printer Trap Numbers” 
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(page 122). The number (128) of the received trap indicates 
that the cover of the printer is open. 
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19. The KPM Printer Utility (External 
Tool) 

19.1. Purposes and Limitations
The Kyocera Print Monitor (KPM) PC-program uses SNMP to 
retrieve the printer status and for printer configuration. 
The KPM-program is available for download at the Kyocera 
web site. Look for example at http://www.service.kyocera.de/. 
The program runs on 16 and 32 bit Windows platforms.
KPM is capable of retrieving the status of many printers sup-
porting SNMP including non-Kyocera printers. It is also capa-
ble of receiving status messages sent from a printer to the 
Intermate LAN FS3. Therefore, printers attached to this print 
server can be monitored in the same way as any other printers 
you want to monitor with KPM.
KPM can also be used to configure Kyocera printers.
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19.2. Configuration Tips
Figure 17. Main screen of the KPM program

The PC running the program should be on the same LAN seg-
ment as the printer to be monitored. If this is not the case, 
another segment can be chosen by selecting Options > KPM 
Settings and clicking the Discover Mode tab (shown on the 
next figure)
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Figure 18. KPM Settings dialog box

The Polling Time should also be checked. This is done by 
clicking the Polling fan.
Further configuration of the program is described in the pro-
gram's help section.
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20. Printer and Job Status via "Finger" 
(External Tool) 

20.1. Purposes and Limitations
With the TCP/UP Finger command you can get the following 
information for the system target printer:

• Interface Type (that is, type of print server)

• Firmware Version 

• Name (“Host Name” (page 58), not “Device Name” 
(page 60))

• Printer Type

• Printer Job Status (up to three queued jobs)

• Printer Status
NDO users must remember that the system target printer can 
either be the local printer or a network destination.
The TCP/IP Finger command is supported on Windows NT / 
Windows 2000 / Windows XP (as a DOS command) and Unix 
systems. 
In order to use it, you must be able to ping the Intermate LAN 
FS3. 
If you cannot ping it, you probably need to establish a static IP 
route between the management PC and the print server.
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20.2. How to Use It

Syntax
finger @<IP address>

Example (where the system target printer is on 192.168.1.188)
Command:

finger @192.168.0.227

Reply:
[192.168.0.227]
Interface Type : LAN FS3, Ver: K92_2011, Name: fs3a
Printer Type: LASERJET 4000
Printer Job Status: RAW Socket 0 192.168.1.188
Printer Status: Ready

Printer Job Status shows the first three jobs queued for print-
ing; if there are none, the message is No Job In Queue" . 
Each job shows  the print protocol and where the job originated 
(IP address). 
If more than three jobs are queued the sequence ",..." is written 
after the third job.
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Upgrade Components: What and How
21. Upgrade Components

21.1. What and How

21.1.1. How to Get Upgrades
Regular firmware releases are made including new features 
and correction of errors. New firmware releases are made 
available on our web site. Partners are notified by e-mail when 
there are new releases.

21.1.2. How to See Which Firmware is Currently Loaded
The version numbers of the firmware currently loaded in the 
print server can be seen in the following status information:

• Main Status Pages (print-out from HTTP menu or from 
the TEST button - see “Information from LEDs and from 
the TEST Button” (page 166))

• Code Revisions (HTTP menu: “Status” > [Code 
Revisions], displayed on screen only).
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21.2. What the Firmware File Names Mean

21.2.1. Version-Naming System

Example: Firmware component K92_1491. 
The first 3 positions indicate the firmware Component ID. In 
this case it is a Main Code firmware (K92) for the Intermate 
LAN FS3.
The first digit after the underscore is the year of the release 
(2001).
The next two digits give the week number (49) and the last is 
the release level (build) within the week (1).
After testing and documentation are finished, the firmware is 
publicly released, so the public release date is often at least a 
week later than the week number in the firmware name and the 
date displayed in “Status > Code Revisions”.

21.2.2. Overview of Component Types and File Names
We provide the following component types:

• Boot Firmware

Boot Code enables the reception of firmware. The Boot 
Code is rarely upgraded. A faulty upgrade could cause 
the unit to lock, in which case it would have to be re-
initialized. Contact your point of purchase if this 
happens. 

• Main Firmware and API codes

• Fonts for Host Print Options (SCS and IPDS)
The firmware file names, as they appear on the web site, are 
shown in the first column in the tables below. Upgrade meth-
ods are also mentioned, while instructions on how to use a 
given method are found in the three chapters following this 
one. Note that the IMCU can be used to update several print 
servers at once (see “Bulk Upgrade” (page 152)) - provided that 
all the servers involved are based on the same software com-
ponent and that they all have the same password.
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21.3. “FSS-Files”
Boot Code and Main Code are upgraded via FTP directly, via 
FTP initiated and controlled by the IMCU, or via the Intermate 
Download Utility in conjunction with a serial upgrade cable. 
Note that the IMCU can be used to update several print serv-
ers at once.

HPO Fonts are upgraded via FTP directly, or via FTP initiated and 
controlled by the IMCU. Note that the IMCU can be used to 
update several print servers at once. 

File Name Files Included

K91-xxxx.zip K91-xxxx.ffs The Boot Code for the Intermate LAN FS3. 

K92-xxxx.zip K92-xxxx.ffs The Main Code for the Intermate LAN FS3. 

K65-xxxx.zip K65-xxxx.ffs The IPDS API Code. This code is downloaded to the 
printer at power up when IPDS printing is enabled.

File Name Files Included

K66-xxxx.zip K66-xxxx.ffs The SCS Fonts for TN5250E used in connection 
with SCS/DCA printing from AS/400.

F08-xxxx.zip font240.ffs The IPDS Font Files bitmap fonts, 240 dpi fonts.

F09-xxxx.zip font300.ffs The IPDS Font Files bitmap fonts. 300 dpi fonts.

Note: There is only room for one set of IPDS fonts at a time; the unit is delivered with 300 dpi. 
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21.4. Configuration Files
Factory default settings are written into a database where they 
cannot be affected by what you do as a user.
The FTP directory in the print server holds at least one, and 
sometimes up to 10 different FTP-”files” reflecting the current 
settings for the server.

21.4.1. “The” configuration file: ima_cfg.bin 
The FTP file that is always present is ima_cfg.bin.
This file contains all current settings except print-server-spe-
cific identifying information (IP address, host name, and the 
like) and the “IDB” settings described below (page 138). 
When your print server is factory new, ima_cfg.bin contains 
only factory defaults. Each time you save your own settings, 
they will replace the original values in ima_cfg.bin. And each 
time you restore factory defaults, the original values replace 
your own values in ima_cfg.bin.
You can use transfer the settings in ima_cfg.bin from one print 
server to another or to several others. This means that you can 
make a single configuration and then quickly set up several 
identically configured print servers.
As with all other operations involving the print server’s FTP 
directory, you can use FTP directly (see “The Binary Configura-
tion File (ima_config.bin)” (page 144)) or use the IMCU (see 
“Using the IMCU for Maintenance” (page 146) and especially 
Figure  on page 150). Note also that the IMCU can be used to 
update several print servers at simultaneously (see “Bulk 
Upgrade” (page 152)) - provided that all the servers involved 
are based on the same software component and that they all 
have the same password.
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21.4.2. .IDB
The IBM Host Print Options for SCS/TNe operate with collec-
tions of settings known as “IDBs”. 
At any one time, the print server’s FTP directory can hold one 
TN3270e IDB and up to 8 TN5250e IDBs. 
And again, you can use FTP directly or use the IMCU. Note 
that the IMCU can be used to update several print servers at 
once - provided that all the servers involved are based on the 
same software component and that they all have the same 
password.
For detailed information on TN5250E, see the Printing Environ-
ment Guide for IBM OS/400 Systems. 
For detailed information on TN3270E, see the Printing Environ-
ment Guide for IBM Main-frame Hosts or the equivalent sec-
tions in the LAN FS3 10/100 Ethernet User’s Guide (KL008-
02). 
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21.5. The Print Server’s FTP Directory and Its Libraries
In connection with various kinds of upgrading, it is important to 
know what structure of the FTP Directory is. 
In the list below, only the libraries which could be important for 
you to know about are shown, and a colon separates the 
library name from the file name(s). The versions indicated 
reflect the newest available in February 2002. 

• BOOT: K91_1071.FFS

• MAINCODE: K92_2011.FFS

• TN3270IDB: (one IDB file if TN3270E is activated)

• TN5250IDB: (one or more IDB files if TN5250 is 
activated)

• IPDSFONT: FONT300.FFS (There are two alternative 
IPDS font files: FONT300.FFS and FONT240.FFS. A 
version number is not a part of the component name)

• TN5250FONT: K66-0151.FFS 

• QUICKGUIDE: QGUIDE.TXT (A version number is not 
part of the file name)

• IPDS: K65_0441.FFS

• REBOOT: holds two files. 
One called "controlled", the other called "immediate".

• CONFIG: ima_cfg.bin
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21.6. How to Inspect the FTP Directory
1 Start an FTP session on the print server (sample IP 

address):
ftp 192.168.0.227

2 You will be asked to give your user name (admin) and the 
password (case-sensitive). 

3 Change to the correct library.
cd <libraryname>

4 List the library contents.
dir

5 If you want to see another library, move up to the root again
cd ..

and repeat steps 3 and 4.

6 Close the FTP session.
bye
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22. Using FTP Directly

22.1. Upgrades of Firmware and Fonts (FFS files)
1 Download the firmware file from the Intermate web site. 

As our example, let us take the main code K92_2011.zip 
. 

Note: You will need a decompressing tool based on the 
ZIP algorithm (for example WinZip®).

2 A single left click on the file name will bring up a File 
Download dialog box asking whether you want to open the 
file or save it. 

When you open it (directly or after having saved it), you can 
then extract K92_2011.ffs to an accessible place on your 
PC or other host. This could, for example, be 
C:\PrintServerUpdates. 

3 Start an FTP session to your Intermate LAN FS3.
ftp 192.168.0.227

4 Give the user name and password for the print server.
5 Change to the library containing the firmware component to 

be upgraded. To fit our example, you would do this:
cd Maincode 

Important:
Be sure to select the correct library. Storing the wrong 
type of file in the wrong place can cause the system to 
lock. 
 

6 Select binary transfer mode.
binary

7 Download the file from your PC to the print server. The 
syntax is:

  put <source> <target>
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The file name in the <source> part of the command must 
match the case of the file name on your PC. 

The file must have the same name when it is "put" on the 
target, so prevent typographical errors by not specifying a 
name for the <target>.

Example:

  put C:\PrintServerUpdates\K92_2001.FFS 

8 Wait for the file transfer to complete. During file transfer, the 
Activity LED (yellow-orange) will flash; when the transfer is 
complete, it will turn off.

9 If you have more upgrading to do, repeat steps 5 - 8.
Important:

Before attempting to move to a new directory, you must 
first go up to the root again

cd ..
10 If you want to activate the settings from the HTTP menu, 

close the FTP session
bye

Otherwise, activate the new settings from within the FTP 
session.

cd .. Move one directory level up
cd \reboot Change to the "reboot" directory
get immediate Perform an immediate reboot or
get controlled perform a controlled reboot

The FTP session is automatically terminated.
Rebooting will take longer than usual because the flash mem-
ory is being programmed. While this is happening, both LEDs 
are lit. When both LEDS go out briefly, the programming is 
done. The print server should then return to “Ready” in the nor-
mal operation mode: the green LED (Activity) on and the 
orange-yellow LED (Link) off.
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22.2. Upgrades of IDBs 
If the file you want to load from our web-site is a so-called IDB 
file, right-click on the file name and choosing “save object” to 
place the file on an accessible drive. This replaces steps 1 and 
2 above. 
When you get to step 7, you can choose another name for the 
<target> than that in the <source>, and in this case, of course, 
both names must be included in the “put” statement. 
Be careful about naming; please consult the Printing Environ-
ment Guide for your IBM OS/400 System or IBM Mainframe. 
This is also where you will find information on managing your 
own IDBs.
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22.3. The Binary Configuration File (ima_config.bin)
The binary configuration file is located in the CONFIG library. 
The file name is ima_cfg.bin.
You will only want to work directly with this configuration file if 
you have made settings in one print server that you want to 
transfer to another. Therefore, you must first retrieve the file 
and save it on an accessible drive; then you can load the file 
from this drive to the PDF directory of another print server. The 
name of the drive and library you use could, for example, be 
C:\PrintServerConfigs.
When a configuration file is retrieved, the settings activated on 
the last reboot or start-up are copied. Changes made after a 
reboot are not contained in the file.
In the example below, we will take the configurations from the 
print server at 192.168.0.227 and transfer them to another print 
server at 192.168.0.170.

To retrieve
1 Start an FTP session to the print server whose 

configurations you want to transfer.
ftp 192.168.0.277

2 Change to the CONFIG library.
cd Config 

3 Change to binary transfer mode.
binary

4 Retrieve the binary configuration file.
Syntax: get <source> <target>.

The file name in the <source> part of the command must 
match the case of the file name in the FTP directory. 
Example:

get ima_cfg.bin 
c:\PrintServerConfigs\ima_cfg.bin

5 Terminate the FTP session.
bye
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To store (load) to the print server
1 Start an FTP session to the print server you want to transfer 

settings to
ftp 192.168.0.170

2 Give the user name and password for the print server.

3 Change to the CONFIG library.
cd Config 

4 Change to binary transfer mode.
binary

5 Store the binary configuration file 

Syntax: put <source> <target>.

The file name in the <source> part of the command must 
match the case of the file name on your PC.

The file must have the same name when it is "put" on the 
target, so prevent typographical errors by not specifying a 
name for the <target>.

Example:
  put C:\PrintServerConfigs\ima_cfg.bin

6 Continue as described in steps 8 - 10 on page 142.
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23. Using the IMCU for Maintenance

23.1. Advantages
The IMCU has three great advantages when working with one 
print server at a time: 

• It allows you to incorporate the process of checking for 
and downloading new firmware versions in to your 
loading procedure.

• It initiates and controls an FTP session and saves you 
from having to know library and file names in the print 
server’s FTP directory. (However, in order to find 
appropriate information in the documentation, you still 
need to be aware of the different file types as listed on 
page 148.)

• It allows you to transfer settings directly from one print 
server to another (see page 150).

The IMCU also makes it possible to do bulk upgrades, that is to 
update several print servers simultaneously. This assumes that 
all the print servers you want to include in a bulk upgrade have 
the same password. 
Note: You must use Internet Explorer 4.01 or later to be 

able to upload a file from your local computer. Any 
version of Netscape should work also, but this has 
not been thoroughly tested.
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23.2. Single Print Server
1 Log in to the IMCU server program.

2 Display the “Device list”.

3 Use the “Expand” icon to bring forth a list of 
devices discovered on the segment where the 
print server you want to update or transfer settings 
to is located.

4 Make sure that you have the “Links” column 
displayed. If there are many columns displayed, 
you may have to scroll to the right to find it. If it’s 
not there you need to adjust your column selection. 

5 Refresh the information on the segment.

6 Locate the Intermate LAN FS3 to be upgraded.

7 Find the “firmware upgrade” icon in the “Links” 
column. Clicking on it will bring up a list as shown 
below in the next step.
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8

Mark the types of files to be upgraded. 

About file types 
Main Code, Boot Code, IPDS Code and  IPDS Font files, SCS 
Font files are FFS files. See “Upgrades of Firmware and Fonts 
(FFS files)” (page 141).

The two kinds of IDBs are briefly described in “Rebooting will 
take longer than usual because the flash memory is being pro-
grammed. While this is happening, both LEDs are lit. When both 
LEDS go out briefly, the programming is done. The print server 
should then return to “Ready” in the normal operation mode: the 
green LED (Activity) on and the orange-yellow LED (Link) off.” 
(page 142), which also refers you to where you can get detailed 
information appropriate to your IBM host environment (OS/400 
systems or Mainframe). 

“Configuration” refers to your own configurations as described 
in “The Binary Configuration File (ima_config.bin)” (page 144). 
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9 Finish by clicking [Next].

10 For each file type you have selected, the IMCU will ask you 
for the physical location of the desired file in the LAN 
environment.  The examples below illustrate two file types. 

FFS files, such as "Main Code 

If you have previously upgraded a device of this type, the 
IMCU server will keep the FFS file(s) in a folder called 
“Firmware”, located in the library where the IMCU server 
has been installed. See the radio button on the top half of 
the screen shot above
If you want to select a different file you must select it from 
the local computer. 

If you haven’t already saved the file you want to use on an 
accessible drive, you can use the link provided to the 
product web site. Find the file you want and save it (see 
page 136 if you need help to do this). Then return to the 
“select” dialog and type in the file name (full path), or use 
the “Browse...” button.
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Configuration file

If you choose to select a file on your local computer, you 
must first have retrieved it from the source; see “To retrieve” 
(page 144) in the chapter on upgrading directly with FTP.

Finish each file selection with “Next > “. 
11 Repeat the process of selection for each type of file you 

have checked.

12 The final “Next>” in connection with file selection will bring 
you to a dialog in which you must specify the user name 
and password for the server in question. 

13 You will then be asked whether or not you want the IMCU 
to reboot your Intermate LAN FS3 after the upgrade. 

If you are absolutely sure that there are no current print jobs 
which can be ruined by an “immediate reboot”, it is safe to 
answer yes. 

If not, you must remember to do a “controlled reboot” 
afterwards, directly from the print server. 

14 When you click “Next>” again, the updating will start.

15 The process is usually very fast, but if you get impatient, be 
careful not to switch off the print server, or shut down the IMCU 
server (by closing the browser) during the upgrade. 
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If you want to do other things with your browser while 
waiting for the update, you can either open a new instance 
or continue in the same instance by typing a new URL in the 
address box. If you continue in the same instance, you can 
use the browser’s “back” and “forward” arrows to move 
among the different things you have running.
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23.3. Bulk Upgrade

When you are done with steps 1 - 5 as described 
starting on page 147, click on the “Bulk Firmware 
Upgrade” icon, located in the top row of icons.

Your click will bring up a dialog like this:

Note the following things about this dialog.
The devices displayed are only those with firmware that the 
IMCU is able to recognize and put the files in the correct library 
in the FTP directory.

Use the “upgrade” check box to select a device for upgrading.
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You can use the check mark to select all the devices 
listed by a given agent segment. But do so only if they all 
are the same type of print server (interface firmware 

component, such as G32 or K92) and all have the same pass-
word.

This (European) minus sign deselects all the devices 
listed by a given agent segment.

When you continue with “Next”, the procedure is the same as 
described for upgrading single servers, starting with step10 on 
page 149.
Intermate LAN FS3  Print Server Administration Manual 153 



Upgrade of Main Code or Boot Code Using a Serial Cable: The Cable
24. Upgrade of Main Code or Boot Code 
Using a Serial Cable 

This approach can only be used with FFS files. 
To use it, you need a suitable cable and the Intermate Down-
load Utility Program (p16-xxxx).

24.1. The Cable
Files are downloaded via an DB9-PS/2upgrade cable 
(described in the Product Overview) to the serial I/O port (con-
sole port) built in to the PS/2 connector on the Intermate LAN 
FS3. 
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24.2. The Intermate Download Utility Program
This is a free program included on the CD and also available 
from our web-site. The program is a native 32 bit 
Windows95/98/NT4.0 application. It is installed by executing 
the file P16-xxxx.exe.
When the Download Utility is used for the first time the Com-
munication Port (COM port) and Baud Rate settings should be 
checked. The COM port is the PC port the upgrade cable is 
plugged into. The Baud Rate may vary depending on the PC. 
Usually a rate of 19.200 bps is good.
Files must first be saved on an accessible drive on a PC (see 
“Upgrades of Firmware and Fonts (FFS files)” (page 141)).
Files are downloaded by connecting the PC running the utility 
to the printer via the serial upgrade cable.
The printer must be powered Off before it is connected to the 
PC. 
Do NOT power it On until asked to by the Download Utility.
The Download menu is activated from the keyboard <Alt+d>. 
Select the file as always in a Windows program.
Click on the “Open” button to initiate the download and follow 
along with what happens on the screen.
When you are asked to power On, you must first press the 
“TEST” button and keep holding it while powering On. This is 
necessary in order for the unit to enter “Download” mode. 
The Activity LED is ON and the Link LED is OFF when the 
Intermate LAN FS3 is in “Download” mode. 
On reboot, both LEDS light during programming of the Flash 
memory. When both LEDS go out briefly, the programming is 
done. The print server should then return to “Ready” in the nor-
mal operation mode: the green LED (Activity) should be on and 
the orange-yellow LED (Link) should be off.

Refer to the Intermate Download Utility program's on-line help 
pages for further detail. These are accessed via the help menu 
(<Alt+h>).
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25. Overview of Types of Resets

25.1. Activate New, Saved Settings with a Reboot
To activate any new setting, the unit must be rebooted. 
Rebooting resets the information in the System Log. So you 
may want to print out the Main Status Pages before rebooting.
There are two kinds of normal reboots: “immediate” and “con-
trolled”.

• “Reboot (immediate)” reboots the Intermate LAN FS3 
immediately, terminating any current print job and. Jobs 
queued after a terminated job are not affected.

• “Reboot (controlled)” performs a delayed reboot. A 
reboot command is added to the job queue. The reboot 
is carried out when there are no more jobs known to the 
Intermate LAN FS3.

Both types of reboot can be achieved remotely through HTTP-
menu, a Telnet client or an FTP session.
When you load firmware, fonts, etc. using the IMCU, you can 
also use the IMCU to perform an Immediate remote reboot.
Finally, can do a hardware reboot, which is useful in certain sit-
uations (for example those described in “Restore Factory 
Defaults: TEST Button” (page 158)). Hardware reboots can be 
done by turning the printer Off and then On. It is best to wait 
about 10 seconds from the last saving until you power Off. 
After a reboot, it takes up to 30 seconds before the print server 
is Ready.
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25.2. Restore Factory Default Settings: Remote

HTTP Menu: Configuration Page Only
On each configuration page, there is a “Factory Default” but-
ton. This will reset all the parameters on the page, and only on 
that page.
Reboot to activate the change.

HTTP Menu: “Restore All Defaults”
This is something very rarely done.
This menu item is in In the “Actions” group on the left menu. 
“All Defaults” includes both the contents of the configuration file 
and specific identifying information (such as IP address, host 
name, and license key). 

Note for users of SCS TN5250E and SCS TN3270E: 
Included in the configuration file is the association of a 
given IDB name and a session but not the “IDB” settings 
themselves.

Reboot to activate the change.
If you have problems doing a total reboot remotely, use the 
TEST Button instead.

Telnet Client: 
Restoring factory defaults is not possible using Telnet. 
Intermate LAN FS3  Print Server Administration Manual 157 



Overview of Types of Resets: Restore Factory Defaults: TEST Button
25.3. Restore Factory Defaults: TEST Button 

General Information
You can do two types of resets. The difference between them 
depends on how long you hold the Test Button before letting 
go. 
Use a pointed object to press the Test Button in. If you are not 
good at counting seconds, you should make sure you can see 
a watch or clock that shows seconds.
Caution:
Resetting requires the printer engine to be warm. 
If the engine is cold, you should power the printer On and wait for 
it to report Ready. When it does, you can power it Off and perform 
the reset operation you wish.

a Turn the printer off.

b Press the TEST Button. 
c Turn the printer On while you keep holding the 

Button for:

d When you let go of the Button, a confirmation 
page will be printed if the reset has been 
successful.

e Reboot. A hardware reboot is easiest— power 
the printer Off and then On.

number of seconds: Result

less than 31 sec. Reset IP address to 0.0.0.0, subnet mask to 255.255.255.0 
and default gateway to 0.0.0.0

more than 41 sec. Restore All Defaults. 
This is just like the remote “Restore All Defaults”.
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Customer Support: Where to Find Support

Appendix A. Customer Support

A.1. Where to Find Support
LCI Intermate A/S provides full technical support for this prod-
uct. Contact information is found on the title page of this guide 
- as well as on HTTP menu and on every print out of the Main 
Status Pages.
If you encounter problems, or have questions on how to use 
the Intermate LAN FS3, however, please start by contacting 
your point of purchase. 

A.2. Gathering Information
Always include the following steps when you start to trouble-
shoot:

1  Print out the Main Status Pages for the Intermate LAN FS3. 
The Main Status Pages will show error messages and/or 
warnings, corresponding to the information which is 
displayed on screen by choosing “Status”> [System Log].

2 You may also want to print out the printer’s status pages; 
refer to your printer documentation. This is especially 
relevant for users of the Intermate LAN FS3. 

3 Note the release levels of both the firmware, main software, 
LAN boot code and the printer's firmware. Check our web-
site to see if there are updates. 

4 Update everything you can, and then try again.
If you need to seek specialist help, make as complete a 
description of the error situation as possible. A special area of 
interest is whether the error can be provoked and reproduced, 
or if it is occurring randomly. In addition, you should describe 
the environment as precisely as you can. This involves the 
configuration description of the TCP/IP, servers, printers, LAN 
type, etc.



Technical Information: Hardware
Appendix B. Technical Information

B.1. Hardware
Figure 1.  What the Back Panel Looks Like

Port for Ethernet LAN cable: This is an RJ-45 connector includ-
ing auto detection of 10BaseT and 100BaseTX. In units sold 
before 4 January 2002 (up to and including K92_1491) there is 
also auto detection of Ethernet II, IEEE802.2, IEEE 802.3 and 
SNAP frames. 
Serial I/O (console) port: PS/2.

You will need a LAN drop cable, which is not included.

Complete information on the LED Patterns and TEST Button is 
in the appendix “Information from LEDs and from the TEST But-
ton” (page 166).
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B.2. Supported Printers and Performance Features

Monochrome printers:
FS-600
FS-680
FS-800
FS-1000
FS-1200
FS-1700+
FS-1750
FS-1800
FS-3700+
FS-3750
FS-3800
FS-6700
FS-6900
FS-7000
FS-7000+
FS-9000

Color Printers:
FS-5800 C
FS-5900C
FS-8000C

Digital Copiers:
KM-4230
KM-5230
KM-6230
- and any other Kyocera-Mita printers or copiers which are sold 
from an authorized dealer with the Intermate LAN FS3 already 
installed.Always be sure to use the newest available firmware.
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IPDS printing is only available in the monochrome printers. For 
IPDS printing, a printer must have at least 12 MB RAM and in 
many cases, 16MB is advisable.

The performance-related features of the hardware are as fol-
lows:

• MCF 5206e RISC Processor with 23 MIPS 
performance

• 2 Mbyte DRAM

• 2 Mbyte Flash memory for micro-code.

• Support for both 3.3 v and 5v KUIO port technologies.

If you purchase and enable the Network Destination Option 
(NDO), up to four network printers— attached to the LAN with any 
kind of print server you wish—can be made known to the 
Intermate LAN FS3, thus making the facilities of one multi-proto-
col print server available to up to five different printers. 
The Intermate LAN FS3 retrieves printer status information 
from a network printer through SNMP. For this to function prop-
erly, a network target printer must support the status informa-
tion nodes defined in the Printer MIB (RFC1759) and some 
host information nodes of the Host Resources MIB (RFC1518). 
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B.3. Emission Notices and Approvals

USA: FCC Rules Part 15, Class A
This equipment generates, uses, and can radiate radio fre-
quency energy and if not installed and used in accordance with 
the instruction manual, may cause interference to radio com-
munications. 
It has been tested and found to comply with the limits for a 
Class A computing device pursuant to Subpart B of Part 15 of 
FCC rules, which are designed to provide reasonable protec-
tion against such interference when operated in a commercial 
environment. 
Operation of this equipment in a residential area is likely to 
cause interference in which case the user at his own expense 
will be required to take whatever measures may be required to 
correct the interference. 
Shielded cables should be used with this unit to ensure compli-
ance with the Class A limits.

EU: EMC, CE Declaration of Conformity 

  This product complies with the harmonized standards 
for EN55022: 1998 Class B and EN55024; 1998.
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Hardware Installation:

Appendix C. Hardware Installation

You need a screwdriver to perform the installation.
If the printer is going to be used for IPDS printing and needs 
extra printer memory, please install this extra memory before 
installing the LAN FS3 in the printer. 
Discharge yourself from static electricity before unpacking or 
otherwise handling the unit. Do this by touching an unpainted 
part of the printer’s metal cabinet. Alternatively, you can wear 
an anti-static wrist strap.

1 Power Off the printer.
If the printer is not powered Off before the installation, 
parts of the print server or the printer may be 
permanently damaged.

2 Remove the metal plate covering the KUIO port by taking 
out the screws with a screwdriver. Refer to your printer 
documentation.

3 Remove any interface or cable occupying the internal KUIO 
port you wish to install the unit in. 

Be sure to check that this is OK with the network 
administrator.

4 Slide the card into the internal KUIO port. Secure its 
position with the screws. 

5 Insert a LAN drop cable from your LAN in to the print server.
6 Power On the printer.It is usually a good idea to document 

current settings and save the pages for reference. If you 
wish to do this, wait until the printer reports Ready (the print 
server should have only one LED lit: the green one). Then 
press the TEST Button for 1 or 2 seconds. This will print the 
Main Status Pages for the unit. 



Information from LEDs and from the TEST Button: LED Patterns in Various Modes
Appendix D. Information from LEDs and 
from the TEST Button

Refer to “What the Back Panel Looks Like” (page 161) to see the 
location of the LEDs and the TEST Button.

D.1. LED Patterns in Various Modes

Basic Operation:
Upper LED is yellow-orange - “Activity”. 
It is lit when data is received and turned off when no data is 
present.
Bottom LED is green - “Link”. 
It is lit when the print server has established a link with the 
LAN. If the link is lost, the LED is turned off.

Power Up Mode:
Activity On & Link Off = Powering Up
Activity Off & Link On = Unit is Ready

Normal Operation Mode:
Activity Off & Link On          = On-line with LAN
Activity Flashing & Link On = LAN traffic detected
Both Off                                 = no LAN detected / off-line

Download Mode with Intermate Download Utility & 
Serial Cable: 
Activity On & Link Off
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Download Mode via FTP or FTP controlled by the 
IMCU:
Activity Flashing & Link On

“Programming Flash Memory”: 
This mode occurs during the first reboot after download of new 
firmware, file, etc.
Both On = programming in progress.
Both Off very briefly = programming finished.
Then the print server returns to normal operation mode, 
Ready: Activity Off & Link On.
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D.2. TEST Button to Print Main Status Pages or Quick 
Guide

The TEST button is located on the side of the unit. It is oper-
ated with a pen or similar pointed object.
When you want to print information using the TEST button, you 
must make sure that the LED display shows the green light, 
and only the green light, which indicates that the Unit is Ready.
.

The Main Status Pages describe all current configurations, 
firmware level and the content of the System Log (errors, 
etc).since the last reboot. 
The same Main Status Pages can also be printed from the 
HTTP menu by choosing [Print Main Status Pages] from the 
“Action” group.
The Quick Guide is a mini-manual meant to help you if it is not 
convenient or possible to use the complete documentation.
The Quick Guide can also be printed from the HTTP menu by 
choosing [Quick Guide] in the “Help” group.

Pressed while operational (“Ready”) Result

Press & hold 1-2 seconds for less than 4 
seconds

Print Main Status Pages (shortened to 
Status Pages on the label).

Press & hold for at least  4 sec. Print on-board Quick Guide
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Appendix E. ASCII 7-bit Character Set: 
Decimal Values 32 - 126 

This table is an extract of the 7-bit ASCII character set. For 
each decimal value 32 - 126 inclusive, the Hex values and 
ASCII character are shown. The characters produced by lightly 
shaded values (32 and 123-126 decimal) are not quite as uni-
versal as is the case with the others in the able. 
Each group of three columns is to be read downward through 
two pages.

Decimal Hex ASCII Decimal Hex ASCII Decimal Hex ASCII

32 20 space 64 40 @ 96 60 "

33 21 ! 65 41 A 97 61 a

34 22 " 66 42 B 98 62 b

35 23 # 67 43 C 99 63 c

36 24 $ 68 44 D 100 64 d

37 25 % 69 45 E 101 65 e

38 26 & 70 46 F 102 66 f

39 27 ' 71 47 G 103 67 g

40 28 ( 72 48 H 104 68 h

41 29 ) 73 49 I 105 69 i

42 2A * 74 4A J 106 6A j

43 2B + 75 4B K 107 6B k

44 2C , 76 4C L 108 6C l

45 2D - 77 4D M 109 6D m

46 2E . 78 4E N 110 6E n

47 2F / 79 4F O 111 6F o
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48 30 0 80 50 P 112 70 p

49 31 1 81 51 Q 113 71 q

50 32 2 82 52 R 114 72 r

51 33 3 83 53 S 115 73 s

52 34 4 84 54 T 116 74 t

53 35 5 85 55 U 117 75 u

54 36 6 86 56 V 118 76 v

55 37 7 87 57 W 119 77 w

56 38 8 88 58 X 120 78 x

57 39 9 89 59 Y 121 79 y

58 3A : 90 5A Z 122 7A z

59 3B ; 91 5B [ 123 7B {

60 3C < 92 5C \ 124 7C |

61 3D = 93 5D ] 125 7D }

62 3E > 94 5E ^ 126 7E ~

63 3F ? 95 5F _

Decimal Hex ASCII Decimal Hex ASCII Decimal Hex ASCII
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Appendix F. String Syntax

F.1. Basic Rules and Encoded Bytes
A string can consist of both character strings and other ele-
ments.
Character strings consist of printable characters, all of which 
are treated as case-sensitive. The phrase “printable charac-
ters” means all characters within the decimal range 32 - 126 or 
hexadecimal /20 - /7E; see “ASCII 7-bit Character Set: Decimal 
Values 32 - 126” (page 169). Character strings are enclosed 
within quotes, e.g. “This is a string”. 
If you write your strings in Kyocera Prescribe, all characters will 
be printable, so you only need to remember to enclose the 
commands in quotes. If you write your strings in HP PCL or 
similar printer control language, you will also need to use other 
elements written directly in hex or decimal notation. By “other 
elements” is meant characters outside of the permissible range 
for inclusion in character strings. In order to enter these char-
acters, you must type in the decimal or hexadecimal values 
directly. 

• Decimal numbers are written without any special 
indicators, e.g. write 65 as 65. The allowable decimal 
range is 0 - 255.

• Hexadecimal numbers must be preceded by a slash, 
e.g. /1B. The allowable hexadecimal range is /00 - /FF.

The characters you type in are not all encoded in the flash 
memory.  For example, assume that you have some reason to 
represent the letter B in hexadecimal, you would type in the 
string /42.This encodes to B and fills only 1 Byte of flash 
space; in other words it only fills 1 Encoded Byte. 
When you mix elements in a given string entry, you must sepa-
rate them with commas. The string "A",/42,"C" encodes 
to ABC and fills 3 Encoded Bytes.
If an element separator within the command sequence is ille-
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gal, the whole string is considered invalid and ignored. The 
next section gives examples of valid and invalid strings. 
Note: A pair of double quotes "" cannot be written as a 

normal string, i.e. within quotes. They have to be 
written with their decimal or hexadecimal number: 
34,34 or /22,/22. 

F.2. Examples of Valid Strings and Invalid Strings

Valid Strings Valid Strings (continued)

"abc",/41 65,/41

"abc",65,/41 /41,65

"abc","def" /41,/1B,"a"

"abcdef" /41,/1b,"a"

"abc",65,66,32,/1B,/1B,"def" "/1B,65,abc,def,127"

27,65 /1B,34,/65

Invalid Strings Why

abc,65 - quotes are missing around "abc"

/41,abc - quotes are missing around "abc"

/41abc - a comma is left out and quotes are missing

65,"abc"/1B - a comma is left out

"abcdef",/1B,65,"ahg - end-quote is missing

"abc,/1B,65 - whole string could be considered a string, but 
isn’t because the end-quote is missing

1B,65 - slash before hexadecimal number is missing

65,66,ab" - start-quote is missing

/1B,,65 - two consecutive commas
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Appendix G. Configuration Checklists

G.1. Overall Checklist
1 Establish contact. 

Assign IP address, subnet mask, default gateway.

2 Login. The default password is admin and the password is 
admin.

3 Configure the remaining parameters in [TCP/IP] 
configuration: 
•  Host name is mandatory. Check the syntax guidelines.

•  DNS server is where the Intermate LAN FS3 does look-
ups 
if you enter names instead of IP addresses for various 
servers and hosts in other configurations. 

•  Registering a WINS server makes your Intermate LAN 
FS3 known to an NT environment. 

4 Configure the [General] settings and [Network] settings.

5 Change the password.

6 Enter your license key if you have purchased one or more 
of the available options: Network Destination Option 
(NDO); Host Print Option (SCS TNe and/or IPDS).
If your point-of-purchase has already installed a Software 
Key, it will be written on the label on the back of the unit. 
If you get a key yourself, we recommend that you write it on 
the label.

7 Configure one or more target printers (physical printers(
•  Configure the local printer; this is the printer to which 

the Intermate LAN FS3 is directly attached.

•  If you have the NDO, configure up to four network 
printers.

8 Configure logical printers as needed (see below, step 3, 
page 175).
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9 If you wish, configure one or more status monitoring aids. 
You can choose from among e-mail, notification, SNMP and 
enabling of the embedded IMCU agent.

10 Configure the services you want to use from among the 
following possibilities—and use the “Checklist for Each 
Service or Host Session” (page 175) for each:
•  IPP (Internet Printing Protocol)

•  Raw Socket TCP Port (up to 4)

•  LPR queue (up to 8 configurable queues; there are also 
4 non-configurable queues)

•  FTP

•  IPDS

•  TN5250E (host-sessions - up to 4)
•  TN3270E (host-session)

11 Remember that it is necessary to reboot in order to activate 
new settings.

12 It is always a good idea to document your configurations by 
printing the Main Status Pages.
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G.2. Checklist for Each Service or Host Session 

Printer Definitions on the Host
For each service, you must configure one or more printer-defi-
nitions (often just called “printer”) on the host(s). 

"Host" in this context should be understood as the origin of a 
print job sent to the Intermate LAN FS3.  
You may need to cycle back and forth a few times to coordi-
nate the settings on the Intermate LAN FS3 with the host 
printer-definition(s).

Settings on the Intermate LAN FS3
Configuration is done on one or more configuration pages ded-
icated to the particular kind of service or host session. The 
details are different for each type of service. But the following 
things are common to all:

1 Each configuration page must be saved before leaving it.

2 No configuration pages are activated until you reboot. You 
will usually do and save several pages before rebooting.

3 Each service must know where to direct output.

This is done by choosing a value in the "Use logical printer" 
field. You can only choose a target printer via a logical 
printer. If you have the NDO, you must use logical printers 
to reach your network printers, even if you do not need the 
special data manipulation features in the configurable 
logical printers.
 

4 If the output is to be directed to one of the configurable 
logical printers, check the configuration page [Logical 
Printers 1-8] and make sure that the definition of your 
chosen logical printer does what you want it to:

•  Does it point to the target printer (Local Printer, single 
Network Printer  / Network Destination or Load 
Balancing Pool) you want to be used for printing this 
kind of job?
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•  If the target is a load balancing pool, are the printers 
compatible with each other and are they listed in an 
appropriate order? 

•  Are "string before" and/or "string after" (if any) correctly 
defined?

•  Are substitution string(s) (if any) correctly listed? 
And have they been properly entered in the [String 
Substitutions] configuration page? 

5 Check to be sure the target printer is configured properly

•  If the target printer chosen is a network printer, then 
find this printer under “Output Control” > [Network 
Printers (NDO)]. Check to see that the IP address (or 
name) is ok, that the marked print method (Raw Socket 
or LPR) works on the printer, and that the necessary 
information for the chosen print method is properly 
entered. 

•  If the chosen target is a  load balancing pool, then 
check to see that all of the printers in the pool are 
configured properly.

•  After rebooting, choose “Status” > [Target Printer Info] 
to do a last check of the network printers.
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